Pacesetter
BES Lettering 2
Instruction Manual
Copyright

© Copyright 2011 Pulse Microsystems Ltd. All rights reserved.

This instruction manual and software are copyrighted by the developer of the software, Pulse Microsystems Ltd. All rights reserved. US Patent Nos. 5 270 939; 5 343 401; 5 430 658; 5 506 784; 5 510 994; 5 541 847; 5 668 730; 5 771 173; 5 809 921; 6 196 146; 6 216 618; 6 390 005; 6 968 255. European Patent Nos. 0545773. Other patents pending.

Information in this document is subject to change without notice.

The software described in this document is furnished under a license agreement and/or nondisclosure agreement. The software may be used or copied only in accordance with the terms of those agreements. No part of this publication and the software may be copied, photocopied, reproduced, translated, or reduced to any electronic medium or machine-readable form without the manufacturer’s written permission.

Commercial or industrial use of trademark and copyrighted works (For example, books, paintings, drawings, photos, fanciful characters, and so forth) owned by other companies or persons, for creation of embroidery patterns without permission is illegal and may result in either criminal or civil liability.

Microsoft®, Windows® XP, Windows® Vista, and Windows® 7 are registered trademarks of Microsoft Corporation. All other product names are copyrighted and registered trademarks or trademarks of their respective holders. All computer and software names identified by TM or tm are trademarks of their respective manufacturers.
# Table of Contents

Learning about the Workspace ........................................... 5  
Parts of the Workspace .......................................................... 6  
   Title Bar .............................................................................. 6  
   Pacesetter Button .............................................................. 6  
   Quick Access Toolbar ......................................................... 7  
Toolbar and Ribbon Buttons ................................................. 13  
   Pacesetter Menu Tools .......................................................... 13  
   Extra Tools ......................................................................... 14  
   Ribbon Tools ....................................................................... 14  
   The View Tab ...................................................................... 18  
   Simulator ........................................................................... 19  
   Status Line ................................................................. 20  
   Color Palette ...................................................................... 21  
   Using Scrollbars ................................................................. 21  
   Correcting Mistakes ........................................................... 22  
Setting up your Workspace Environment ................................... 22  
   Changing Machine Format Properties .................................. 23  
Adjusting the View of the Workspace ....................................... 24  
   Magnifying and Reducing the View ...................................... 24  
   Hiding the Sequence and Properties Panels  
      Automatically .................................................................... 25  
   Viewing Different Parts of the Workspace  
      (Panning) ....................................................................... 26  
   Taking Measurements ......................................................... 27  
Displaying the Hoop .............................................................. 27  
   Viewing and Hiding the Hoop .............................................. 28  
   Selecting a Hoop ................................................................. 28  
   Creating a Custom Hoop ..................................................... 29  
Getting Help ........................................................................ 30  
   Opening the Help ............................................................... 30  
   Using the Contents .............................................................. 31  
   Using the Index ................................................................. 31  
   Using Search ................................................................. 31  
   Saving Favorite Help Topics ............................................... 32  
   Printing Help topics .......................................................... 33
Creating Lettering

Creating Lettering
Normal Text Tool
Path Text Tool
Custom Shapes for Text on a Path
Vertical Text Frame
Circle Text Tool
Creating Monograms
Normal Text Tool
Path Text Tool
Creating Lettering

Text Frames - an Overview
Adjusting Size of a Text Segment
Adjusting the Width of Text
Adjusting the Corners of Text Segments
Using the Envelope Handles
Rotating Text
Adjusting the Slant of Text
Adjusting the Size of Text in the Circle Frame
Adjusting Text Width in the Circle Frame
Changing the Diameter of the Circle Frame

Working with Individual Letters
Adjusting the Space between Letters (Kerning)
Moving Individual Letters
Resizing Individual Letters
Rotating Individual Letters

Working with Individual Letters

Working with Color
Changing the Color of a Text Segment
Creating Multi-color Text Segments
Changing Colors in a Two-color Font

Text Properties

The Properties Panel
Adjusting Text Properties
Changing the Text
Changing the Font of Existing Text
Displaying a Font's Available Characters
Spell Checker
Changing the Height of Lettering
Changing Font Spacing
Width Percentage
Changing the Slant Setting
Applying an Envelope
Drop Caps ................................................................. 66
Properties Specific to Particular Text Frames .......... 67
Changing Properties with the Context Menu
(Right-click) .............................................................. 68
Text Styles Option ...................................................... 70
Run Style Text ............................................................ 70
Steil Style Text ........................................................... 71
Appliqué Style Text ................................................... 72
Adjusting Fill Settings .................................................. 78
Choosing a Fill Pattern ................................................ 79
Fill Density Setting ...................................................... 80
Carved Fill Properties ............................................... 81
Underlay Properties .................................................. 82
Selecting the Underlay Type ....................................... 83
Specifying the Underlay Density ........................... 83
Specifying the Underlay Stitch Length ................ 84
Changing the Inset Distance .................................. 84
Pull Compensation Settings ....................................... 85
Displaying Special Characters ................................ 86

Editing Designs .......................................................... 91

Creating New Designs ............................................... 92
Opening and Closing Designs .................................... 93
Opening Files with the Browser ................................ 94
Choosing the Default Recipe ................................... 97
Saving a Design ......................................................... 98
Selecting and Moving Parts of a Design .................. 99
The Select Tool ......................................................... 99
Copying, Cutting, and Pasting Design
Components ................................................................ 102
Aligning Items in the Design Horizontally
and Vertically ......................................................... 103
Moving Parts of a Design Manually ......................... 104
Nudging Design Components ................................ 105
Deleting Design Components ................................ 105
Rotating Design Components ................................ 106
Working with the Color Palette .............................. 107
Selecting a Thread Chart .......................................... 107
Searching for a Specific Color ............................... 107
Changing a Thread Color ......................................... 108
Special Design Tools ................................................................. 109
Merging Design Files ............................................................... 109
Add Designs Feature ................................................................. 111
Distorting Segments ................................................................. 113
Working with Name Drops ......................................................... 117
Adding Basting Stitches to Designs ......................................... 120
Sequencing Outline Segments .................................................... 121
Sequencing Segments ................................................................. 121
Inserting Segments Earlier in the Segment Sequence ......................... 122
Moving a Segment Forward or Backward ................................. 123
Moving a Segment to the Start or End of the Design ..................... 124
Moving a Segment to the nearest Matching Color Group ................. 126
Using the Color Sort tool ............................................................ 128
Printing Designs ........................................................................ 129
Previewing a Design before Printing ......................................... 129
Printing Design Worksheets ....................................................... 130
Changing the Print Settings ......................................................... 131

Foreign Language Fonts .......................................................... 133
Greek font ................................................................................ 134
Greek Block font ..................................................................... 135
Greek Mixed font ................................................................. 136
Hebrew Traditional font ............................................................. 137
Russian font ............................................................................ 138

Glossary .................................................................................. 139

Index ...................................................................................... 145
Before you start using the software, we recommend that you understand the Pacesetter BES Lettering 2 design workspace and learn a few of the basic components outlined in this section.

Topics covered in this chapter:

• Setting up the design workspace environment.
• Showing a hoop in the workspace, and choosing the size of hoop to be displayed
• Creating your own customized hoop.
• Using the Pacesetter BES Lettering 2 help.
Parts of the Workspace

The Pacesetter BES Lettering 2 workspace contains a number of different areas which have distinct functions. The sections that follow give an overview of what each of these areas does, and the kinds of information about the design that they contain.

Title Bar

The Title Bar appears at the top of the Pacesetter BES Lettering 2 design window. The Title bar displays information about the design that is open in the workspace: its name, the number of stitches and colors in the design, and the overall width and height.

Pacesetter Button

At the top left-hand corner of the window is the Pacesetter Button. Clicking on the Pacesetter Button gives you access to a menu of useful tools, such as New, Save, Print, and...
several others. For a complete list of the tools available on this menu, and a summary of their functions, see “Pacesetter Menu Tools” in the next section.

When you open the Pacesetter Menu, you will also see displayed a list of recent files that you have been using. Just double-click on the file name to open it.

![Tools available on the Pacesetter Menu.](image)

**Quick Access Toolbar**

The Quick Access Toolbar is located right along the top of your workspace, to the left of the Title Bar. This toolbar contains tool buttons that you will commonly use, such as Open, Save, and Print; but it is fully customizable, meaning that you can add the tools you personally use most often, for easy access. See “Customizing the Quick Access toolbar”.
To start out, the following default tools are included on the Quick Access toolbar: New, New/Recipe, Open, Merge, Save, Print Preview, Direct Print, Undo, and Redo.

Customizing the Quick Access Toolbar

One important advantage of the Quick Access toolbar is that it is fully customizable. This means that you are able to select tools from any of the Pacesetter BES Lettering 2 toolbars and add them to the Quick Access toolbar. You do this by way of the Customize function, which is accessed by clicking the small down arrow to the right of the Quick Access toolbar.

To customize the Quick Access toolbar:

1. Click the down arrow at the right end of the Quick Access toolbar.
   
   You see a menu.

2. Click on More Commands...
   
   You see the Customize dialog.

   ![Customize Quick Access Toolbar]

   - New
   - Open
   - Save
   - Direct Print
   - Undo
   - Redo
   - More Commands...
     - Show Below the Ribbon
     - Minimize the Ribbon

2. Click on More Commands...
   
   You see the Customize dialog.
3 From the “Choose Commands from:” list, select the toolbar containing the command you want.

*The list of tools on that toolbar now appears in the “Commands” box.*

4 Select the desired tool from within the “Commands” box, and click Add>>.

*The selected tool appears in the list of Quick Access toolbar tools.*

5 Repeat steps 3-4 until you have added all the tools you want to the Quick Access toolbar.

6 If there is a tool on the Quick Access toolbar that you do not want to have on there, select it in the right-hand box and click on the Remove button in the dialog.

7 When you have added and/or removed all the buttons you want, click OK.

*The dialog will close; the Quick Access toolbar will be changed accordingly.*
Adding Separators in the Quick Access Toolbar

You have the option of also adding separators in the Quick Access Toolbar. These are small vertical marks which appear on the Quick Access Toolbar, and divide the commands into groups for ease of use. A separator is added just the same way as you add commands; select <separator> in the “Choose commands” list and then click the Add >> button.

Here is an example of how the separators work. If you create an arrangement of separators and commands in the Customize dialog that looks like this,

```
Open
New
<Separator>
Save
Direct Print
<Separator>
Undo
Redo
```

The Quick access toolbar will be organized to look like this:

```
Home Arrange View
```

For more details, see the procedure outlined above, “Customizing the Quick Access Toolbar.

You can change the position of a separator, or any command in the Quick Access Toolbar. Select it in the box to the right in the Customize dialog, and click the up and down arrows on the right. This will move the command or separator relative to the other commands in the Quick Access Toolbar.
Customizing Keyboard Shortcuts

Another useful feature of the More Commands menu item (on the Quick Access Toolbar) is that it gives you the option of assigning your own custom keyboard shortcuts. Keyboard shortcuts can be very useful for those tools that you use most often.

**To assign keyboard shortcuts:**

1. Click the down arrow at the right end of the Quick Access toolbar.
   
   *You see a menu.*

2. Click on More Commands...
   
   *You see the Customize dialog.*

3. Click the Customize button.
   
   *You see the Customize Keyboard dialog.*
4 From the “Categories” list, select the category containing the command you want.

The corresponding list of commands appears in the “Commands” box.

5 Select a command to which you would like to assign a shortcut.

6 Click in the “Press new shortcut key” field.

7 On your keyboard, press the sequence of keys that you want to use; these keystrokes will appear in the field.

If there are two or more keys used in the shortcut, a plus sign (+) will be inserted between them, to indicate that they are to be used in combination. The (+) on your keyboard is not part of the shortcut sequence.

8 Click the Assign button to create the custom shortcut.

The shortcut sequence will be moved into the Current Keys field.

9 Repeat steps 3 - 7 until you have created all the desired keyboard shortcuts.

10 Click close.
Toolbar and Ribbon Buttons

You can access the tools available in Pacesetter BES Lettering 2 through the Pacesetter Button and the various toolbars. The tables below show the buttons, grouped by location (i.e. whether they are on the Quick Access Bar, or on one of the tabs on the ribbon). A brief description of what the button does is also included. Note that within each tab, some buttons are grouped together by function.

Pacesetter Menu Tools

<table>
<thead>
<tr>
<th>Tool</th>
<th>What it means</th>
</tr>
</thead>
<tbody>
<tr>
<td>New:</td>
<td>Creates a new untitled design.</td>
</tr>
<tr>
<td>New/Recipe</td>
<td>Opens a new page and allows you to choose a new recipe and machine format.</td>
</tr>
<tr>
<td>Open:</td>
<td>Opens an existing design file.</td>
</tr>
<tr>
<td>Merge:</td>
<td>Opens the Merge Design dialog, which you can use to import existing stitch or outline files into the current design.</td>
</tr>
<tr>
<td>Browser:</td>
<td>Opens a the Browser window, a dialog box which allows you to search all your computer’s disks and directories for design files.</td>
</tr>
<tr>
<td>Save:</td>
<td>Saves the current design.</td>
</tr>
<tr>
<td>Save As:</td>
<td>Opens the Save As dialog, allowing you to choose the destination and file type to save it as.</td>
</tr>
<tr>
<td>Print:</td>
<td>Opens the printer dialog on your computer, allowing you to choose your printer and adjust the printer’s properties.</td>
</tr>
<tr>
<td>Direct Print:</td>
<td>Prints a copy of the design worksheet, bypassing the printer dialog.</td>
</tr>
</tbody>
</table>
The Ribbon appears below the Title Bar. The Ribbon has three tabs, the Home tab, the Arrange tab, and the View tab. Clicking on the tabs displays all the buttons for the functions that are under that tab.

Tools on the Home Tab

<table>
<thead>
<tr>
<th>Tool</th>
<th>What it means</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="select.png" alt="Select" /></td>
<td><strong>Select</strong>: Selects objects in the design window.</td>
</tr>
<tr>
<td><img src="select-all.png" alt="Select All" /></td>
<td><strong>Select All</strong>: Accessed via the drop-down menu from the Select tool. Selects all items in the design workspace.</td>
</tr>
</tbody>
</table>

**Print Preview**: Opens the print preview window, which in turn will let you print the current design.

**Print Setup**: Opens the print preview window, which in turn will let you print the current design.

**Close**: Closes the file that you are currently working on (the active file) leaving any other files open.

**Close All**: Closes all files that are open on your computer.

**Exit**: Closes all open files and shuts down Pacesetter BES Lettering 2; you will be prompted to save any open files.

**Extra Tools**

<table>
<thead>
<tr>
<th>Tool</th>
<th>What it means</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="undo.png" alt="Undo" /></td>
<td><strong>Undo</strong>: Reverses your last action.</td>
</tr>
<tr>
<td><img src="redo.png" alt="Redo" /></td>
<td><strong>Redo</strong>: Reverses the action of the Undo command.</td>
</tr>
</tbody>
</table>

**Ribbon Tools**

The Ribbon appears below the Title Bar. The Ribbon has three tabs, the Home tab, the Arrange tab, and the View tab. Clicking on the tabs displays all the buttons for the functions that are under that tab.
## Learning about the Workspace

<table>
<thead>
<tr>
<th>Tool</th>
<th>What it means</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Cut</strong></td>
<td>Cuts the selection and copies it to the clipboard.</td>
</tr>
<tr>
<td><strong>Copy</strong></td>
<td>Copies the selection to the clipboard.</td>
</tr>
<tr>
<td><strong>Paste</strong></td>
<td>Pastes the clipboard contents into the design, at the end of the design sequence.</td>
</tr>
<tr>
<td><strong>Insert</strong></td>
<td>Pastes a copy of the clipboard selection into the sewing sequence immediately following the selected segment.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Removes the selected segment.</td>
</tr>
<tr>
<td><strong>Text</strong></td>
<td>Creates lettering placed along a straight baseline.</td>
</tr>
<tr>
<td><strong>Text on Path</strong></td>
<td>Creates text segment along a path. The path may be chosen from a pre-defined list of shapes, or you may create your own shape.</td>
</tr>
<tr>
<td><strong>Vertical Frame</strong></td>
<td>Creates vertical lettering.</td>
</tr>
<tr>
<td><strong>Circle Frame</strong></td>
<td>Creates lettering based on a circular baseline.</td>
</tr>
<tr>
<td><strong>Monogram Frame</strong></td>
<td>Creates three-letter monogram text.</td>
</tr>
<tr>
<td><strong>Name Drops</strong></td>
<td>Quickly create a number of distinct designs, based on a single design, but each with different text string included.</td>
</tr>
<tr>
<td><strong>Add Designs</strong></td>
<td>Adds decorative features to your design - accents, appliqués, borders, and frames.</td>
</tr>
<tr>
<td><strong>Auto Baste</strong></td>
<td>Automatically adds an outline of basting stitches around the current design.</td>
</tr>
<tr>
<td><strong>Color Sort</strong></td>
<td>Automatically reduces the number of thread changes that are required in a design, by re-arranging the sewing sequence so that like colors are together.</td>
</tr>
<tr>
<td>Tool</td>
<td>What it means</td>
</tr>
<tr>
<td>---------</td>
<td>---------------</td>
</tr>
<tr>
<td>3D</td>
<td>3D: Realistically renders your design onscreen.</td>
</tr>
<tr>
<td>Grid</td>
<td>Grid: Displays a background grid, which helps with alignment. This grid can be used for the alignment of items on the display.</td>
</tr>
<tr>
<td>Hoop</td>
<td>Hoop: Displays the hoop as it fits relative to the embroidery. Clicking this button a second time will turn the view of the hoop off.</td>
</tr>
<tr>
<td>Select Hoop</td>
<td>Select Hoop: Accessed via the drop-down menu from the Hoop tool. Opens up the Select Hoop window, in which you can choose a new hoop.</td>
</tr>
<tr>
<td>Fit Hoop</td>
<td>Fit Hoop: Accessed via the drop-down menu from the Hoop tool. Scales the design up to the maximum size of the selected hoop on the design window.</td>
</tr>
<tr>
<td>Background</td>
<td>Background: Two options are available from this button, Select Color or Select Fabric. Depending on which one you choose, a dialog box will open in which you select either the color, or the fabric pattern, that appears in the background of the active design window.</td>
</tr>
<tr>
<td>Ruler</td>
<td>Ruler: Measures the distance between any two points in a design.</td>
</tr>
<tr>
<td>Zoom</td>
<td>Zoom: Magnifies the design to fit a rectangle drawn by the user with the mouse pointer.</td>
</tr>
<tr>
<td>Zoom in</td>
<td>Zoom in: Magnifies the view of the design by a fixed amount.</td>
</tr>
<tr>
<td>Zoom out</td>
<td>Zoom out: Shrinks the view of the design by a fixed amount.</td>
</tr>
<tr>
<td>Fit to Window</td>
<td>Fit to Window: Displays the entire design and loaded images in the window.</td>
</tr>
<tr>
<td>Back to 1:1</td>
<td>Back to 1:1: Returns design to original size.</td>
</tr>
<tr>
<td>Slider</td>
<td>Slider: Drag the slider to choose a specific level of magnification; displays percentage of original size.</td>
</tr>
<tr>
<td>Pan</td>
<td>Pan: Allows you to move the design around in the workspace window by clicking and dragging.</td>
</tr>
</tbody>
</table>
### Tools on the Arrange Tab

<table>
<thead>
<tr>
<th>Tool</th>
<th>What it means</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Select</strong></td>
<td>Selects objects in the design window.</td>
</tr>
<tr>
<td><strong>Select All</strong></td>
<td>Accessed via the drop-down menu from the Select tool. Selects all items in the design workspace.</td>
</tr>
<tr>
<td><strong>Distort</strong></td>
<td>Displays the Distortion dialog, which you can use to add interesting effects to the selected design.</td>
</tr>
<tr>
<td><strong>Align Left</strong></td>
<td>Aligns all selected objects with the left-most item selected.</td>
</tr>
<tr>
<td><strong>Align Right</strong></td>
<td>Aligns all selected objects with the right-most item selected.</td>
</tr>
<tr>
<td><strong>Align Top</strong></td>
<td>Aligns all selected objects with the top-most item selected.</td>
</tr>
<tr>
<td><strong>Align Bottom</strong></td>
<td>Aligns all selected objects with the bottom-most item selected.</td>
</tr>
<tr>
<td><strong>Horizontal Center</strong></td>
<td>Takes all selected objects and centers them in the selection box. The objects are moved so that they are centered left-to-right with each other, but they are not moved up or down.</td>
</tr>
<tr>
<td><strong>Vertical Center</strong></td>
<td>Takes all selected objects and centers them in the selection box. The objects are moved so that they are centered top-to-bottom with each other, but they are not moved left or right.</td>
</tr>
<tr>
<td><strong>Center</strong></td>
<td>Centers one or more selected objects proportionally within the current hoop. If more than one object is selected, the entire group is moved together to the center of the hoop; the objects selected remain in the same position relative to each other as they had before being centered.</td>
</tr>
<tr>
<td><strong>Flip Horizontal</strong></td>
<td>Flips one or more selected objects horizontally.</td>
</tr>
<tr>
<td><strong>Flip Vertical</strong></td>
<td>Flips one or more selected objects vertically.</td>
</tr>
<tr>
<td><strong>Rotate Left</strong></td>
<td>Rotates one or more selected objects to the left by 90 degree increments.</td>
</tr>
<tr>
<td><strong>Rotate Right</strong></td>
<td>Rotates one or more selected objects to the right by 90 degree increments.</td>
</tr>
</tbody>
</table>
The View Tab

The controls on the View tab allow you to change what appears on your workspace; which panels are displayed, whether or not commands and stitch points are shown in the design, and so on. The areas found on this tab are Windows, Show/Hide, and Program Preferences.

Windows

In the windows area, check the box to show the corresponding window or panel, and uncheck it to hide that window or panel.

- Sequence. Shows/hides the Sequence view.
- Palette. Shows/hides the thread palette.
- Properties. Shows/hides the properties panel.
- Simulator. Shows/hides the sewing simulator.
- Status. Shows/hides the status bar.

Show/Hide

Check the boxes to show the corresponding symbols in the Design Workspace.

- Entry/Exit. Shows the position of the first and last points in the sewing of a segment.
- Commands. Displays icons in the workspace that show where the color changes and trims are.
- Stitch points. Shows the penetration points of the stitches.

Program Preferences

Click on the Program Preferences button to open a dialog in which you can set the default machine settings, change the units of measure, and choose settings for the workspace grid. For more information on this dialog, see “Setting up your Workspace Environment”
Simulator
The Simulator makes it easy to see on-screen how your design will sew out. You can use the Simulator to eliminate potential sewing problems.

When you select Simulator from the View tab of the Ribbon, the Simulator (scrollbar slider and the sewing simulator) will appear at the bottom of the design space. The Simulator controls which parts of the design are drawn in the design window.

You can also open and close the Simulator by pressing Ctrl + R.

Scrollbar Slider

The length of the scrollbar slider represents all of the stitches in the opened design. You can move the scrollbar slider by dragging it to see a design as it will look sewn to a particular point. The color display within the scrollbar indicates the thread color that will be sewn when the scrollbar slider is positioned over it. Clicking on the arrows at the ends of the scrollbar will advance or retrace the design position by one stitch.

Sewing Simulator

The sewing simulator allows you to watch your design draw on a stitch-by-stitch basis, simulating the sewing action of your machine. The Simulator controls include pause, stop, sew forward and sew backwards. You can push various control buttons and slide the speed control to vary the rate of sewing.
Using the Simulator

The following table explains how to use the Simulator in more detail:

<table>
<thead>
<tr>
<th>Tools</th>
<th>What is does</th>
</tr>
</thead>
<tbody>
<tr>
<td>⬅️</td>
<td><strong>Previous Stitch</strong>: Move backward in the design by one stitch.</td>
</tr>
<tr>
<td>🔄</td>
<td><strong>Scrollbar slider</strong>: Drag the scrollbar slider to advance the design to a specific position. When the scrollbar slider is positioned over a color, you will see the specified thread color being sewn in the design. The entire length of the scrollbar slider represents the entire design.</td>
</tr>
<tr>
<td>➤️</td>
<td><strong>Next Stitch</strong>: Move forward in the design by one stitch.</td>
</tr>
<tr>
<td>⬅️</td>
<td><strong>Simulate Sewing (backward)</strong>: Move backward through the design.</td>
</tr>
<tr>
<td>Pause/Stop</td>
<td><strong>Pause/Stop</strong>: Pause or stop the design while drawing. When you play or resume sewing your design, stitching will continue from the location of the last stitch.</td>
</tr>
<tr>
<td>➤️</td>
<td><strong>Simulate Sewing</strong>: Move forward through the design.</td>
</tr>
<tr>
<td>Speed</td>
<td><strong>Speed</strong>: Slide the speed control to vary the rate of sewing.</td>
</tr>
</tbody>
</table>

**Status Line**

The Status Line appears at the bottom of the Pacesetter BES Lettering 2 window. To show or hide the Status Line, go to the Windows area of the View Tab and check or uncheck Status.

As you move the mouse over different sections of the workspace, this indicator will tell you what that area or button does. You will also find specific design information in other areas of the status bar; it shows the total number of segments in the design, the number of segments currently selected, the machine format, the recipe used by the current design, the number of stitches in the selected design components and the hoop being used.
Color Palette
The thread colors for the design are shown in the Color Palette located along the top edge of the workspace. To show the Color Palette (if it is not already displayed), go to the Windows area of the View tab and check the Palette box.

The color palette in Pacesetter BES Lettering 2.

For more information on the color palette, see “Changing Thread Colors.”

Using Scrollbars
Scrollbars are tools in the workspace that enable you to move easily around within the displayed design. There are two scrollbars, one for moving the view vertically, and one for moving it horizontally.

How to use the scrollbars:
• To pan left/right, or up/down, click and drag the track button.
• Click on the small arrows at each end of the scrollbar to move the design view incrementally.
• Click in the track of the scrollbar, to move the workspace view by one whole screen

You can also right-click the scrollbar to display a pop-up menu of scroll actions. The menu displays the following options:

<table>
<thead>
<tr>
<th>Scroll Here</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top</td>
</tr>
<tr>
<td>Bottom</td>
</tr>
<tr>
<td>Page Up</td>
</tr>
<tr>
<td>Page Down</td>
</tr>
<tr>
<td>Scroll Up</td>
</tr>
<tr>
<td>Scroll Down</td>
</tr>
</tbody>
</table>


Correcting Mistakes

Undo and Redo are two significant features that allow you to correct mistakes. If you make a mistake and change your mind about an action you just made, Undo reverses the action. Redo puts back the change. If Undo or Redo are grayed out, you cannot Undo or Redo.

To use Undo:
• Do one of the following:
  • On the Quick Access toolbar click the Undo tool.
  • Press Ctrl+Z on your keyboard.

To use Redo:
• Do one of the following:
  • From the Quick Access toolbar, click the Redo tool.
  • Press Ctrl+Y on your keyboard.

Setting up your Workspace Environment

Pacesetter BES Lettering 2 allows you to set up your design workspace environment for all opened design files. You can predetermine the units of measurement you want to use for your designs.

The following sections describe the units of measurement that can be used for designs opened in Pacesetter BES Lettering 2.

Metric

The dimensions in Pacesetter BES Lettering 2 can be displayed in metric values. This is the default setting, which will appear each time you run Pacesetter BES Lettering 2. It is generally preferable for embroiderers to use the metric values because many of the manufacturers of embroidery machines and designs use metric values.
English vs. Metric

Pacesetter BES Lettering 2 displays inch measurements in tenths of inches. If you think in inches, then you can set the software to use the inch system. Open the Preferences dialog and click on the Environment tab, and select English from the Units list.

To set up your workspace environment:

1. On the View tab of the Ribbon, select the Preferences button.
   You see the Preferences dialog box.
2. Click the Environment tab.
3. From the Units list, select the units of measurement you want used for your designs: Metric or English.
4. Click OK.

Changing Machine Format Properties

All designs in Pacesetter BES Lettering 2 have a machine format. Machine formats have their own profile settings that determine how embroidery information will be interpreted when you save design files.

When you create a new design file, you can select the machine format for the specific design. The selected machine format can change how the design file is read. When you set machine format properties in the Preferences dialog, all new designs will use these machine format properties as the default settings.

If you open a design with the New/Recipe command, you can select the recipe for the new design in the New Page dialog. This will override whichever recipe is set as the default in the Preferences dialog.

Changing machine format properties after a design file has been opened will not change the machine format of the embroidery designs in that design.
To change machine format properties:

1. On the View tab of the Ribbon, select the Preferences button.
   
   You see the Program Preferences dialog box.
2. Click the Formats tab.
3. From the Machine format list, select the machine format that you want applied to new design files.
4. Click OK.

Adjusting the View of the Workspace

Magnifying and Reducing the View

Use Zoom to magnify or reduce parts of your design. With Zoom you can either left-click to enlarge your design or right-click to make your design smaller.

When you select Zoom, the cursor changes to a small magnifying glass. To use the Zoom tool, do one of the following:

- To zoom in on the spot where the mouse is currently pointing, left-click.
- To zoom out again, right-click.
- To zoom in on a particular area, left-click and drag; the display will expand to show only the area that you have dragged over.

To use the Zoom Tool:

1. On the Ribbon, select the Home tab.
2. In the Zoom toolbar, click on the Zoom tool. The pointer becomes a magnifying glass.
3. Do either of the following:
   - Left-click to make your design larger.
   - Right-click that area to make your design smaller.
To zoom-in on a specific area:
1. On the Ribbon, select the Home tab.
2. In the Zoom toolbar, click on the Zoom tool.
   *The pointer becomes a magnifying glass.*
3. Click and hold your mouse button and drag it to form a flexible box around the area you want to see in detail.
4. Do one of the following steps:
   - To increase the zoom, continue clicking and dragging the flexible box.
   - From the Zoom toolbar, click on the down arrow under the Zoom icon, and use the Zoom tool settings to zoom back out.

Additional options on the Zoom Toolbar:
When you click on the down arrow underneath the Zoom Tool, you will see an option menu. You can choose from any of the following options on this menu:
- **Zoom In** to make your design larger.
- **Zoom Out** to make your design smaller.
- **To Fit** to make the whole design the size of the design window.
- **To Selection** to zoom to the size of the currently selected embroidery segment, or set of embroidery segments if more than one is selected.
- **1:1** to see the design at the actual size.

Hiding the Sequence and Properties Panels Automatically
To increase the amount of space for your design window, you can set the Sequence and Properties panels to the Auto hide mode. When Auto hide is on, the panel will only be visible while the mouse is over it; as soon as you remove the mouse, the panel will collapse to a narrow sidebar.

To turn on Auto hide for these panels, click on the small push-pin icon at the top-right of the panel. When the panel is in
Auto hide mode, the small push-pin will be on its side, like this: 
Now, whenever you move the mouse to another part of the screen, the panel will be hidden.
To turn Auto hide off, click on the icon again.

**Viewing Different Parts of the Workspace (Panning)**
Sometimes you may want to work at a high level of magnification, and some part of the garment or embroidery you’re working on will not show up in the workspace. You can move to parts of your design that go beyond the window’s borders. In these situations, you can use keyboard arrows or the pan tool to change your view of the project.

**Panning using the keyboard:**
- Use the key to move up.
- Use the key to move down.
- Use the key to move left.
- Use the key to move right.

**Using the Pan Tool**
Use the Pan tool to move the view of the design around in the workspace by clicking and dragging. While you are using the Pan tool, you will still be able to see the design in the window. Note that the pan tool does not actually move parts of the design around, just your view of them.

You can right-click to switch back to whichever tool you were using before you selected the Pan tool.
Taking Measurements

The Ruler tool lets you measure the distance between any two points in your design workspace. When you measure from one point to another, the distance is displayed in the status line located at the bottom of the window. The status line shows the horizontal and vertical distances the Ruler tool travels from the x and y axes, the angle measured, and the total distances.

To measure Designs:
1. On the Ribbon, select the Home tab.
2. Click on the Ruler tool.
   
   *Your pointer changes to a ruler when in the Design Workspace.*
3. Click and drag your mouse until you are finished measuring the item.
4. Let go of your mouse when you are finished measuring.
5. Look in the status line at the bottom of the workspace to see the measurement.
6. Right-click to set the end point of your measurement.

   *The measurement is now displayed in the status bar.*

Displaying the Hoop

Viewing the hoop or frame on the screen lets you ensure that your design fits properly when you run it on the machine. The hoop serves as a guide to help size and position your design in the design window. Pacesetter BES Lettering 2 comes with many pre-loaded hoop sizes.
Viewing and Hiding the Hoop

Use the Hoop tool to show and hide the hoop in the display window. Just click on the Hoop tool to show the hoop (if it is not currently shown) and click it again to hide the hoop.

The hoop's dimensions are determined by your settings under the Hoops dialog in Pacesetter BES Lettering 2. Using the Hoop tool may effect the magnification level of your design. For example, if you are zoomed in on the design, clicking the Hoop tool will cause the view to zoom out enough to fit the entire hoop into the workspace.

Selecting a Hoop

You can select one of the pre-loaded hoops using the Hoops dialog. You will notice that you can select hoops from different file types in this dialog. This is useful when you want to make sure that your design will fit for more than one kind of embroidery machine.

To select a hoop using the Hoops dialog:
1 On the Home Tab click the down arrow under the Hoop tool.
2 From the menu that appears, click on Select Hoop.
You see the Hoops dialog.
3. Select the machine format from the Format drop-down list.

   If you choose the PES format, you will see that there is an option to select “MultiNeedle” hoops. This applies only if you have a MultiNeedle embroidery machine.

   If you check this box, the list of hoop formats will change to a list of hoops that are used with a MultiNeedle machine.

4. From the list of Hoops, choose a hoop size appropriate for your design.
5. If needed, check the “Rotate 90°” box to make the hoop fit your design better.
6. Click OK.

Creating a Custom Hoop

You can also create your own custom-sized hoops using the Hoops dialog. Once you have set the parameters for your hoop and typed in a description, the custom hoop will be saved by the Hoops dialog; it will be available for your use in future designs.

To add a custom hoop:
1. On the Home Tab click the down arrow under the Hoop tool.
2. From the menu that appears, click on Select Hoop.
   You see the Hoops dialog.
3. Click the New button.
   You see the New Hoop dialog.
4 Enter the dimensions for your new hoop in the Width and Height boxes.
5 In the Name box, type a name for your custom hoop.
6 Click OK.
   The new hoop’s name will now be displayed in the list of hoops that you can select from in the Hoops dialog.
7 Click on the name; the new hoop’s dimensions now appear in the Hoops dialog on the lower right of the dialog.
8 Click Apply.
   The new hoop shows in your design location.

Getting Help

The Pacesetter BES Lettering 2 Help is a quick way to find answers to your questions and see step-by-step instructions. Because a large number of topics exists, the Help allows you to search for topics in various ways. You can search using the table of contents, the index or a database of keywords. You can also save the topics you visit most often.

The help is also available in document form (PDF). To view or print the instruction manual as a PDF, insert your Installation CD and select View Instruction Manual from the options.

Opening the Help

To open the Help:
1 Double-click the Pacesetter BES Lettering 2 icon on your desktop.
   You see the blank design workspace.
2 Click the Help tool.
   You see the Help.
Using the Contents
The Help has a table of contents, with a list of book icons. Each book contains a series of related topics.

To use the Contents:
1 Click the Help tool. 
   You see the Help.
2 Double-click the book you want to open.
3 Click the topic you want to see.
   You see the topic in the right pane.

Using the Index
The Help index is similar to the index in a book.

To use the Index:
1 Click the Help tool.
   You see the Help.
2 In the box, enter the word or words you want to search for.
   In the list, you see the topics that most closely match your query.
3 Click the term you want to learn more about.
   If there is more than one topic for the keyword, you see a menu.
4 Click the topic you want to see.
   You see the topic in the right window pane.

Using Search
The Search tab lets you search using keywords or phrases in a database of all the words found in the Pacesetter BES Lettering 2 Help.

To use Search:
1 Click the Help tool.
You see the Help.

2 Select the Search tab.

3 In the "Keyword" box, enter the word or phrase that you are searching for.

4 Click the List Topics button.
   In the list below, you see the topics that contain the words you searched for.

5 Click the topic you want to view, and then click Display.
   You see the topic in the right window pane.

Saving Favorite Help Topics

The Favorites tab lets you save the topics that you visit most often and want to access quickly.

To save your favorite topics:

1 Click the Help tool.
   You see the Help.

2 Double-click the book you want to open.

3 Click the topic you want to save as your favorite.
   You see the topic in the right window pane.

4 Click the Favorites tab.
   You see the selected topic in the Current topic area.

5 To add the selected topic to your favorites list, click Add.
   You see the selected topic appear in the Topics area.

6 To display your favorite topic, do one of the following:
   • In the Topics area, select the favorite topic you want to display and click Display.
   • In the Topics area, double-click the favorite topic you want to display.
   You see the topic in the right window pane.

7 To remove one of your favorite topics, do the following:
   • In the Topics area, select the favorite topic you want to remove and click Remove.
Printing Help topics
You can print any of the topics in the Help.

To print topics:
1  Click the Help tool.
2  Click the topic you want to print.
   *The topic will appear in the Help window.*
3  Click Print.
   *You see the Print Topics dialog box.*
4  Select one of the following print options:
   • Print the selected topic
   • Print the selected heading and all subtopics
5  Click OK.
   *You see the Print dialog box.*
6  Change any of the print settings, if necessary, and click OK.
   *The topic will be sent to your printer.*
You can add beautiful lettering to your designs using various Pacesetter BES Lettering 2 tools. Generate unique embroidery text in an array of shapes and sizes using our powerful Text tools.

*Topics covered in this chapter:*

- Creating lettering with the Normal, Path, Vertical, and Circle text tools.
- Using the Monogram Text tool to create monogram lettering.
- How to modify blocks of text, and individual letters within text segments.
- Adjusting the spacing between individual letters.
Creating Lettering

There are five different tools which are used to input your lettering into a design: the Normal Text tool, the Path Text tool, the Vertical Text tool, the Circle text tool, and the Monogram tool. The following sections describe how to use these tools.

Normal Text Tool

Normal Text items are created using the Normal Text tool. Normal text items start out with normal proportions for the font, and can be adjusted.

To create normal text:

1. On the Ribbon, select the Home tab.
2. On the Text bar, click on the Normal Text tool.
3. Click once in the design window.
   
   An empty text frame appears in the workspace, and the mouse pointer changes to an arrow with the letter A next to it.

4. Type the desired text string. To create a multi-line text segment, press ENTER, which will drop the cursor down one line, and continue to enter your text.

5. Right-click to complete the text segment.
   
   Your text appears in the design. You can now make any other changes to the text segment in the Text Properties box.

6. To choose a new font (i.e., other than the currently selected one) for the text string at this point, do the following:
   
   - In the Text area of Properties panel, click in the Font field to select it.
   - Click on the down-arrow to the right of the font field.
   
   You see a list of fonts.
• Select the desired font from the list.  
  *A preview of the newly selected font is now displayed at the top of the properties panel.*
• Click **Apply** in the Properties panel.  
  *For information on changing other text settings, see “Normal Text Properties”.*

**Path Text Tool**

The Path Text tool creates lettering that follows a set linear path. For example, you can use the Path tool to create text that bends to follow the curved edge of a garment.

![Path Text Tool Example](image)

Pacesetter BES Lettering 2 comes with a set of shapes already installed for you to choose from, or you can create and save your own shape, using the Edit Shape command.  
See “Creating a Custom Text on a Path Shape”.

**To create text along a path:**

1. On the Ribbon, select the Home tab.
2. From the Edit tool bar, click the Path Text tool.
3. Click once in the design window.

   *If another text object was already selected, your first click only de-selected that object. You will have to click again.*
You see the Select a text path dialog.

4 Select one of the paths from the Select a text path dialog. 

The Select a text path box closes, and you see a blank text frame of the chosen shape in the design window.

Select a font for your text by doing the following:

- In the Text area of Properties panel, click the down-arrow to the right of the font field.
  
  You see a list of fonts.

- Select the desired font from the list.
  
  A preview of the newly selected font is now displayed at the top of the properties panel.

- Click Apply in the Properties panel.

  Important: If you choose a new font, but do not click Apply at this stage, the text will revert to the font previously in use when it is generated.

5 Type the desired text string.

6 Right-click to complete the text segment.

Your text appears in the design. You can now make any other changes to the text segment in the Text Properties box.
For more information on changing text settings, see “Text Properties”.

7 Click Apply.
   Your text will change accordingly.

Custom Shapes for Text on a Path
In addition to the Path Text shapes already installed with your Pacesetter BES Lettering 2 software, you can create and save your own shape, using the Edit baseline command.

You are also able to change the characteristics of the anchor points when in Edit baseline mode; you can convert the anchor point to Line, Cusp, Smooth, or Symmetrical. See “Changing the Anchor Point Type”.

To create a custom path:
1 Select the Path Text tool and use it to create a text segment.
2 With the Path Text still selected, right-click and choose Edit baseline from the options menu.
   The baseline shape appears along the bottom of the text, showing the anchor points (blue squares).

3 To add new anchor points to a Path Text baseline, do the following:
   • Right-click on the line.
   • From the context menu that appears, select Add Point.
   A new anchor point is added to your baseline.
4 Click and drag the anchor points and direction lines to modify the shape of the baseline.
5 Right-click to redraw the lettering so that it follows the new curve.

6 To save your custom shape, right-click and choose “Export Text Path” from the options.
   *You see a Save as dialog.*

7 Type in a name for the new Text Path and click save.
   *The new Text Path will now appear in the Select paths dialog when you use the Text on a Path tool.*

### Changing the Anchor Point Type

When you are editing the baseline of a Path Text segment, you can select anchor points and change their type. An anchor point can be a line, cusp, smooth or symmetrical point. The different types change the way that the baseline curves.

**To change an anchor point to line, cusp, smooth or symmetrical:**

1 Select a Path Text segment.
2 Right-click and choose Edit baseline from the options menu.
3 Hover over the anchor point you want to change (a blue dot will appear next to the mouse pointer) and right-click.
   *You see a shortcut menu.*

![Anchor Point Types](image)

4 Choose one of the following types of anchor points available:
   - **Line:** Removes the direction lines from the anchor point. Creates a straight point without any curved properties.
• **Cusp:** Allows editing of the direction line on one side of the anchor point. Adds a sharp bend to a curve.

• **Smooth:** Constrains the angle of the direction lines to 180° and allows you to vary the length of the direction line on one side of the anchor point. Creates a smooth transition between curved lines.

• **Symmetrical:** Constrains the angle of the direction lines to 180° so the direction lines have the same length on each side of the anchor point. Creates some curvature on both sides of the anchor point.

*You see the segment change accordingly.*

**Vertical Text Frame**

Vertical Text items are created using the **Vertical** tool. Vertical text items are those that are created vertically. They start out with normal proportions for the font, and can be adjusted.

**To create vertical text:**

1. On the Ribbon, select the Home tab.
2. On the Text bar, click on the Vertical Text tool.
3. Click once in the design window.

   If another text item was already selected, your first click only deselected that item. You will have to click again to place a new text segment.

*An empty vertical text frame appears in the workspace.*

4. To choose a new font (i.e., other than the currently selected one) for the text string at this point, do the following:
   
   • In the Text area of Properties panel, click the down-arrow to the right of the font field.
   *You see a list of fonts.*

   • Select the desired font from the list.

   *A preview of the newly selected font is now displayed at the top of the properties panel.*
• Click **Apply** in the Properties panel.

**Important:** If you choose a new font, but do not click **Apply** at this stage, the text will revert to the font previously in use when it is generated.

5 Type the desired text string.
6 Right-click to complete the text segment.

*Your text appears in the design. You can now make any other changes to the text segment in the Text Properties box.*

**Circle Text Tool**

Text on a circular path is created using the **Circle Text** tool. When the text is first created, it is given a default font height and circle diameter, which can be adjusted using the text tools.

**To create Circle Text:**

1 On the Ribbon, select the Home tab.
2 On the Text bar, click the **Circle Text** tool.
3 Click once in the design window.

   *If another text item was already selected, your first click only deselected that item. You will have to click again to place a new text segment.*

   *An empty Circle Frame appears in the workspace.*

4 Type the desired text into the “Upper Text” and “Lower Text” fields in the Properties panel.

   *Text typed in the Upper Text field will be centered at the top of the circle, and will run clockwise, while text typed in the Lower Text field will be centered at the bottom, and run counter-clockwise. For more information, see “Changing Text Direction” in the “Text Properties” section of the manual.*

5 Right-click to complete the text segment.

*Your text appears in the design. You can now make any other changes to the text segment in the Text Properties box.*
To choose a new font (i.e., other than the currently selected one) for the text string at this point, do the following:

- In the Text area of Properties panel, click in the Font field to select it.
- Click the down-arrow to the right of the font field.
  
  You see a list of fonts.
- Select the desired font from the list.
  
  A preview of the newly selected font is now displayed at the top of the properties panel.
- Click Apply in the Properties panel.

Creating Monograms

Monogram Text items are created with the Monogram Text tool. When you create a Monogram text item, it is three letters long by default (but this can be changed on the properties panel). Decorations can be added to Monogram items for those fonts that support them.

To create standard Monogram text:

1. On the Ribbon, select the Home tab.
2. On the Text bar, click on the Monogram frame tool.
3. Click once in the design window.
4. Type the three letters of your monogram into the frame.
5. In the Monogram area of the Properties Panel, select the font you wish to use in the Font field.
6. Click the Apply button at the bottom of the properties panel.

You can also make any other changes to the settings the Properties box.
Text Frames - an Overview

In Pacesetter BES Lettering 2, you can modify your lettering in a number of different ways once you have created it. You can change the overall size of the text, the height, the slant, the spacing between letters (kerning), and so on.

There are two main methods of changing the size and shape of a text segment: directly, by clicking and dragging on the outline handles in the workspace, or indirectly, by changing the parameters in the Text section of the Properties Panel. The following sections will show you how to use handles for direct text manipulation; for more information about how to use the properties panel, see, “Adjusting Text Properties”.

Note that not all of the ways of adjusting the text will apply to all types of text frames; for example, the Envelope function and the Envelope handles, only apply to the Normal Text and Monogram frames only.

Where applicable, the section will list the frame types to which these handle can apply; if not stated, you can assume that the handle is present for all frame types.

Adjusting Size of a Text Segment

To change the size of a text segment manually, you can use the Proportional Sizing handle. This is the green arrow located on the top-left corner of the text frame.

Click and drag on the Proportional Sizing Handle to change the overall size of the text; up to increase the size, down to decrease the size. Note that the size of the text changes proportionally; that is, if you increase the size of the segment, the letters will increase in height by the same degree that they increase in width.
Adjusting the Width of Text

If you want to change the width of the text of segment, without changing the height, use the frame’s Width Handle.

![Image of text frame with width handle](image)

The Width Handle is the green arrow at the bottom-right of the text frame. Click and drag the to right to increase the width, and to the left to decrease the width.

If you want to adjust the height of a design, it can be done in the Height box in the Text tab. Enter the new size and click Apply.

Adjusting the Corners of Text Segments

Use the Corner Handles to change the shape of a text segment. The Corner Handles are at each corner of the text frame, and are pink in color.

![Image of text frame with corner handles](image)

When you click and drag these handles up or down, they change the position of the selected corner of the text frame; when you release the mouse button, the embroidery is regenerated to match the change in shape. This gives you the ability to create text that slopes up or down.

These handles are applicable only to Normal Text frames and Monogram Text frames.
Using the Envelope Handles

These handles apply only to Normal Text and Monogram text items. These two types of text are surrounded by a flexible bounding box, called an envelope. You can adjust this shape by moving the Envelope Handles.

The Envelope Handles are the pink circles, located at the midpoint of the top and bottom borders of the text frame. Click and drag these handles to make the top and/or bottom of the frame concave (“bowed in”) or convex (“bowed out”).

You can also apply an envelope shape to a text segment through the Properties Panel. You can use the Envelope property in the Text area to apply a predefined envelope to a Normal Text or Monogram text item. For more information see “Applying an Envelope” in the “Lettering Properties” section.

Rotating Text

Use the Rotation handle to change the angle of a text segment. This is the orange circle at the top-left corner of the text frame.

To rotate a segment, first position the mouse over this handle so that the cursor will change to a circle-arrow handle. Then, drag the handle to rotate the segment to the desired angle. Drag up to rotate counter-clockwise, and down to rotate clockwise. Notice that, as you rotate, the tool displays an outline preview of the lettering, showing how far you are rotating it. Release the mouse button to “drop” the segment, and generate the stitches at the new angle.
For Circle Frames, note that the rotation handle is appears on the inner circle of the frame, centered under the top text string. See “Rotating Circle Text”.

Dragging this handle rotates the design to any angle. You will see an outline of the design rotate onscreen as you are dragging, and the text will be regenerated when you release the mouse.

**Adjusting the Slant of Text**

The angle of the letters in a text object can be adjusted with the Slant Handle. The Slant Handle is the square blue handle located to the lower-left of the selection box.

To adjust the slant of text, select the text object you want to adjust, click the Slant Handle and drag. To add a forward (positive) slant to the letters, drag to the right and to add a backward (negative) slant, drag to the left.

If, after performing any of the adjustments above, you wish to return the frame to its original size and shape, right click on the workspace and choose Reset Frame from the option menu. The frame will reset itself.
Adjusting the Size of Text in the Circle Frame

The size of text items can be adjusted using the Proportional Sizing Handle. This handle is at the top of the lettering and appears as a blue circle.

Select the Circle Text tool and place your mouse pointer over this handle; you will see that it changes to a small cross.

As you drag this handle, you will see the design scale proportionally, which means that as you make the text taller, it also gets wider.

Adjusting Text Width in the Circle Frame

You can adjust the overall spacing between letters in Circle Text with the Width Handle. This handle appears as a blue circle at the lower-right side of your text.

To adjust the width, select the Circle Text tool, and click on the text to select it. When you place your pointer in the Width Handle, you will see that it changes to a small cross. By dragging this handle, you will be able to adjust the width of the text segment.
Note that the spacing between the lettering changes proportionally as you increase and decrease the size of the segment. To adjust the spacing between letters individually, see “Adjusting the spacing between letters (kerning)” in the “Working with individual letters” section of the manual.

To change the height and width at the same time, see “Adjusting the size of text in the Circle Frame”

**Changing the Diameter of the Circle Frame**

You can change the overall diameter of the baseline of your Circle Text using the Rotation Handle. This is the orange circle on the inner edge of the Circle Text frame. Place your mouse over this handle and the pointer will change to a circle-arrow handle ( ). Then, drag in or out along a radius to increase or decrease the diameter of your Circle Text segment.
Working with Individual Letters

The text tools allow you to make changes to individual letters within the text segments in your designs.

You are able to select a letter, and move it, rotate it, and resize it by using the handles that surround the letter when it is selected. You can also change the spacing of letters within the word with the special kerning handles.

Adjusting the Space between Letters (Kerning)

The space between individual letters can be adjusted using the Kerning Handles.
Kerning Handles are blue diamonds, located between the letters of your text segment. You can drag these horizontally to adjust the spacing of the text.

When you move a kerning handle in a word, you adjust the space between only the two letters on either side of the handle you are moving; the spacing between the other letters remains the same. So, if you add space, you will see the whole length of text expand by this amount.

**Moving Individual Letters**

Individual letters can be moved using the Letter Handles. These appear as blue squares, centered on each letter in the segment.

To select a letter, click on its Letter Handle; once the individual letter is selected, you can adjust its position by dragging with the mouse.

Selecting a letter also activates the Letter Frame around that letter. This frame displays handles that allow you to resize or rotate it; see following sections.

**Resizing Individual Letters**

When an individual letter has been selected, you can resize it by clicking and dragging the Letter Size handles. The Letter Size handles are green squares that are located in the corners of the letter frame.
When you hover over these handles, a double-ended arrow appears; by dragging up or down on this handle, you increase or decrease the size.

**Rotating Individual Letters**

When you select an individual letter with its Letter Handle, you can rotate it by clicking and dragging the Letter Rotation Handles. The Letter rotation handles are the green circles at the corners of the Letter Frame. When you hover over these handles, the mouse pointer will become a circle with arrows, like this. 🔄

Drag up to rotate counter-clockwise, and down to rotate clockwise. As you rotate, the tool displays an outline preview of the letter, showing how far you are rotating it.

When the cursor is placed over the text function handles, the cursor changes for the different functions.
Working with Color

With Pacesetter BES Lettering 2, you are able to choose a text item’s color from a large variety of thread colors. You apply the color by selecting from the colors available in your currently loaded thread palette.

For more information on how to use the thread palette, and how to change the current thread palette, see “Working with the Color Palette.”

Changing the Color of a Text Segment

The following procedure applies to situations where you want to simply change the thread color of an existing text segment to a new color.

To change a thread color of a Text item:
1. Do one of the following:
   • Select the text item in the workspace, using either the Select tool or one of the text tools.
   • Click on the text item in the Sequence view.
2. In the Color Palette, click the color box with the thread color you want to use.

Creating Multi-color Text Segments

When you are creating design compositions involving lettering, you may find that you want to have two or more colors in a single line of text. In Pacesetter BES Lettering 2, this can be easily done using the Properties panel.

You accomplish this by inserting a special character, the tilde (~) into your text. Inserting these characters divides your text segment into sub-segments; each of the sub-segments that are created this way gets its own color identifier label (Color1,
Color2, etc.) and can then be assigned its own thread color from the Color Palette.

To insert thread color changes within a text segment:
1. Select the text segment.
2. In the Text field of the Text Properties panel, type a tilde (~) between letters in each position that you want a color change to occur.

3. Click Apply.
   You see the colors change for all text subsegments after the first one, which retains the original color.

The text segment, as it appears initially, after being divided into subsegments. The first subsegment retains the original color, and the subsequent ones are assigned arbitrary “placeholder” colors (until you chose your own).

4. To apply your choice of colors to the sub-segments, move the mouse pointer to the desired color in the Color Palette and left-click.
   A context menu appears, listing the text sub-segment color identifiers in the order they appear in your text.
Selecting the colors for the individual sub-segments; in this example, applying a red thread color to the first segment, the word ‘Multi’.

5 From the context menu, click on the subsegment identifier to apply the chosen thread color to it.
   The subsegment changes to the chosen color.
6 Repeat step 5) for each subsegment in your list.

![Multi Color Text!](image)

The text segment with new thread colors applied.

The example outlined above demonstrates two color changes being applied between words, but you can apply changes in exactly the same way between individual letters in a word. Note that the tildes do not add any space between characters or words in your text.

Changing Colors in a Two-color Font

You can also choose the thread color for each of the components (that is, the fill and the border) of a two-color font. You apply the color to each by selecting the color you want to use for each from the color palette.

**To change colors in a two-color font:**

1 Create a text segment, using any of the Text tools.
2 In the Properties box, select a two-color font (e.g. 2Cl Team Medium) and click apply.
   The text segment appears in the workspace; colors for the fill and border are chosen arbitrarily.
3 Find the color you wish to apply to the fill of the lettering segment in the color palette, and left-click on it.
You see the following Options menu.

4 In the Options menu, click on Color 1.
The fill color of the lettering changes to the chosen color.

5 Find the color you wish to apply to the border of the lettering segment in the color palette, and left-click on it.
6 From the Options menu, click on Color 2.
The border color of the lettering changes to the chosen color.

You can also apply the border color first, and then the fill color; the order you make the change in makes no difference.
CHAPTER 3:
Text Properties

Topics covered in this chapter:

• Editing text objects using Properties panel settings.
• Using the Styles feature to give a different look to your lettering.
• How to know what characters are available in each font.
• The Spell Checker feature.
• Using the color palette.
The Properties Panel

The Pacesetter BES Lettering 2 Properties Panel appears on the right of the workspace. This panel displays, and allows you to modify, all the properties associated with the lettering in your designs. These properties include the text properties, the fill properties, underlay properties, and pull-compensation properties. Each of these types of properties has its own section in the Properties Panel, and each will be discussed in detail in its own section to follow.

Adjusting Text Properties

The Properties Panel allows you to modify various properties of the currently selected text segment. You can use this area of the panel to change text itself, choose a font, and select the height, alignment, and spacing of the letters. You can also alter the sewing sequence, and determine how trims and lock stitches will be applied to the segment.

The property fields you see in the text area may be different, depending on which kind of text frame is selected; for example, when a Circle frame is selected, this area will show two places where you can input text, labelled 'Upper' and 'Lower'.

The properties that you will see displayed will be slightly different depending on which type of text (Normal, Path, Vertical, Circle or Monogram) is currently selected.

Changing the Text

As well as being able to type directly on the screen (see appropriate sections under "Creating Text"), you can also input your text by typing in into the Text field on the Properties Panel.
Note, however, that there is some variation on what you can type, depending on which kind of Frame is selected. For example, multi-line text segments can only be entered when a Normal Text frame is selected.

To edit text in the Properties panel:
1. Select the text object you want to edit.
2. In the Text area of the Properties panel, click in the Text field to select it.
   If the Properties panel is not already visible, you can display it quickly by pressing Alt + Enter on your keyboard.
3. Type the desired text into the Text field.
4. Click Apply to save your changes.
Changing the Font of Existing Text

You can change the font type of text objects using the drop-down list of fonts in the Properties Panel. At the top of the area, you see a preview image showing a sample of the selected font.

You can choose from two types of fonts at the outset; embroidery fonts or TrueType fonts. The default list of fonts you see in the Text area will be embroidery fonts; to show the TrueType fonts, check the box next to TTF.

When TrueType fonts are used for embroidery letters, the satin stitches that comprise them will sew out horizontally.

Note that, depending on the embroidery font you choose, there are different minimum and maximum height recommendations. For more information, see “Displaying font properties.”

To change a font type:

1. Select the text segment you want to alter.
2. In the Text Properties area, in the TTF field, do one of the following:
   - To choose from the selection of Embroidery fonts, leave the TTF checkbox unchecked.
   - To choose from the selection of TrueType fonts, check the TTF checkbox. The list of available fonts will change accordingly.
3. From the Font list, select the font you want to use.
You can preview the fonts available by clicking the arrow to the right of the font name. This will display a drop-down list of the available fonts; scroll through the list by dragging the track button. You can click on each font name to display a preview of the font in the Text area.

4. Click Apply to save your changes.
   
   You see your text’s font type altered accordingly.

**Displaying a Font’s Available Characters**

In Properties Panel, there is a tool which displays all the characters (keystrokes) that can be entered for available embroidery fonts. For example, some fonts only allow you to enter uppercase characters, while other fonts allow you to enter both uppercase and lowercase characters. The available characters box also tells you the minimum and maximum recommended heights for sewing out the font.

**To display an embroidery font’s available keystrokes:**

1. Display the Properties Panel, if it is not already visible.
2. In the Text area, select the font you want to use in the Font field.
3. Do one of the following:
   - Hover the mouse pointer over the font preview list.
   - Click on the available characters button to the immediate left of the font field.

   A new window displays all the available keystrokes.
Spell Checker

The Spell Checker feature is found in the Properties Panel in Pacesetter BES Lettering 2. You can check the spelling of text segments created in any of the Text, Vertical Text, Path Text or Circle Text modes.

Note that Spell Checker uses the Microsoft Word spell check function, so it only works on computers that have Microsoft Word installed.

To use the Spell Checker feature:

1. Create a Normal, Multi-line, Path, or Circle Text segment.
2. Click the Spell Checker button in the Text field on the Properties panel.
   
   The spell check dialog appears. Any word that is misspelled will be shown in red.

3. To see a list of suggested correct spellings, right-click in the text entry box next to the incorrect word.
   
   A list of alternatives appears beside the mis-spelled word.
4 Click on the correct word that you want to replace the incorrect one, or directly type over the incorrect word to replace it.
   *Your choice replaces the incorrect word.*
5 Click Apply to create the text segment in your workspace.
   *The corrected text appears in your workspace.*

**Rock lobster!**

**Changing the Height of Lettering**

With Pacesetter BES Lettering 2, it is easy to change the height of any lettering. Height refers to the tallest character in the desired lettering. So, when a text segment contains both uppercase and lowercase letters, it is the size of largest uppercase letters (usually) that is set by this property.

**To change the height of lettering:**
1 Select the text object you want to alter.
2 In the Text area of the Properties panel, select the Height field.
   *The property label (Height) is highlighted in blue.*
3 Type in the height you want your letters to be.
4 Click Apply to save your changes.
   *You see your text’s height altered accordingly.*

**Changing Font Spacing**

The font spacing property controls the horizontal spacing between letters in a text segment. The normal (default) value for the font spacing is zero. You can set the font spacing to a negative or a positive value. If you set the value to less than zero, then the spacing between letters decreases; if you set the value to greater than zero, then the spacing increases.
Notice that the spacing property applies to the whole segment. If you want to change the spacing selectively, to individual gaps between letters, you can use the Kerning Handles. See “Adjusting the Space between letters.”

**To change font spacing:**
1. Select the text object you want to alter.
2. In the Text area of the Properties panel, click in the Spacing field to select it.
3. Enter the font spacing value you want to use.
4. Click Apply to save your changes.
   *You see your text’s letter spacing altered accordingly.*

**Width Percentage**

The Width Percentage changes the overall width of a text segment. You can adjust the Width percentage to alter the appearance of the text object, or to allow it to fit the hoop better.

When you change the width of a segment using the Width Handle, the Width Percentage of the selected segment will be adjusted automatically to reflect the change.

**To change width percentage:**
1. Select the text object you want to alter.
2. In the Text area of the Properties panel, select the Width field.
3. Enter the width percentage value you want to use.
4. Click Apply to save your changes.
   *You see your text’s width percentage altered accordingly.*

**Changing the Slant Setting**

Pacesetter BES Lettering 2 allows you to use the Slant setting to create a slanted effect in text objects. Slant changes the degree value of the slant on your lettering. A negative value slants your lettering to the left; a positive value slants it to the right.
Negative slant to the left and positive slant to the right.

To change slant settings:
1 Select the text object you want to alter.
2 In the Text area of the Properties panel, select the Slant field.
3 Enter the slant value you want to use. To slant your lettering to the left, enter a negative value. To slant your lettering to the right, enter a positive value.
4 Click Apply to save your changes.
    You see your text altered accordingly.

Applying an Envelope

One way to vary the shape of your text segment is to use the Envelope setting. This allows you to apply a predefined envelope to change the shape of a Normal Text or Monogram text item.

To apply one of the pre-determined envelope shapes:
1 Select the item with the Text tool, and press ALT + Enter to show the Properties Panel, if it is not already visible.
2 In the Text area of the Properties panel, click on the Select button next to “Envelope.”
    The Envelope window (below) will open.
Select one of the envelope shapes from the list. The selected envelope shape will be applied to your lettering.

**Drop Caps**

Drop Caps is a property that can be modified through the Text area of the Properties panel. It can be used to change the height and vertical alignment of the letters at the beginning of the selected text. There are two settings relating to the Drop Caps Property - Alignment and Percentage.

Use the Alignment option to determine the position of the baseline of the relative to the main lettering. See the examples below, showing Top and Baseline alignment respectively.

The Percentage property determines how much bigger than the main segment the Drop Cap letter will be. This value is
expressed as a percentage, with 100% being equal in size to the main lettering.

Some of the fonts that are installed with the software do not have the capability of working with Drop Caps; for these, the setting will be inactive in the Properties panel.

Properties Specific to Particular Text Frames

Decor for Monograms

Most of the properties of a Monogram are the same as the ones that appear for Normal text; the exception is the Line Spacing property, which does not apply.

There is an additional feature unique to the Monogram properties section, called Decor. Decor consists of pre-designed embroidery that frames the monogram text.

Some example of the monograms made using the Decor Monogram fonts.

Decor is only available when the Monogram is created using the special monogram fonts that support it; these are the ones labelled Decor Monogram in the list of fonts.

You can create a monogram font using another kind of font, but in this case, the Decor option will be unavailable.
If you create your monogram using one of the special monogram fonts, you will see that the Decor Field is active. To choose the decor type for your monogram, you first create a monogram segment, and choose a Decor Monogram style in the font area (see “Creating Monograms” in the “Creating Lettering” section of this manual). Click the down-arrow to the right of the decor field, select a decor from the list, and then click Apply.

If you want to use one of the Decor monogram fonts without the decor, there is the option to do so; just select decor option "00", which is at the top of the list, and essentially means that no decor is added.

Line Spacing

The Line Spacing parameter only applies to the Normal text mode. This property controls the spacing between lines in multi-line text segments. This quantity is expressed as percentage of the Letter Height value.

Align

The Align setting is found only in Normal text mode and can be applied to lettering segments with more than one line. This property is equivalent to the alignment of paragraphs in word-processors; you can align your text on the left, right, or center.

Changing Properties with the Context Menu (Right-click)

You can right-click on any text object, regardless of its type, and an edit menu will appear. This menu allows you to change several important text properties, such as changing or resetting frames.

Changing Text Modes

The Text Mode can be changed for an existing text object in Pacesetter BES Lettering 2. You can change an existing text item to Normal Frame, Path Frame, Vertical Frame, Circle...
Frame, or Monogram Frame. Right-click the text object and select a text mode from the menu.

This feature is useful when the text is already in position, but you want to change the frame that is applied to it. For instance, you may create a normal text object, but then realize you want it to be an Circle text object instead.

### Resetting the Frame

The Reset Frame command is useful when you have altered your text object a bit too much and want to start over.

### Resetting Individual Letters

If you are have selected a single letter in a text segment, the context menu will have an additional option, the Reset Letter command. Use this command in cases where you have manipulated a letter and want to reset it so that it looks as it would if it was never individually adjusted.

This command is available when you activate individual letter size handles and right-click the individual letter with your cursor.

### Changing Text Direction

The text direction setting is applicable only to text segments in the Circle frame.
Initially, when you create a Circle text segment, the letters will start at the top, and read clockwise around the circle (this is ‘Text Direction Normal’). However, if you want the text to start at the bottom and read counter-clockwise instead, you can change to this condition by right-clicking the segment and choosing Text Direction Reverse from the menu that appears.

To get text that goes in both directions, within a single Circle text segment, type text directly into the Circle text properties page: ‘Normal’ direction into the Upper text box, and ‘Reverse’ text into the Lower text box.

If you have text in both the upper and lower text fields, changing the text direction will swap the positions of the two text strings, so you will not have to re-enter them manually.

**Text Styles Option**

There is the option in the Properties Panel, for those fonts that support it, to change the style of the embroidery that is used to draw your lettering. Text Styles is an extra option which you can use to expand the creative possibilities of embroidery lettering.

The default style that is generated when you create lettering is the Satin stitch. However, you can also choose from among five other styles to apply to your lettering: Run, Steil, Appliqué, and Spiral.

Applying the different styles to text will not always produce good results for all letter heights.

Styles cannot be applied to all the available Pacesetter BES Lettering 2 fonts.

**Run Style Text**

When you apply the Run style to the text segment, it converts the outline of the lettering to a run stitch. The potential options are stitch length, and style of Run.

There are four different possible Run styles; single, double, bean, and motif.
• **A Single Run** stitch is a simple forward-moving stitch that looks like any straight stitch produced by a sewing machine.

• **A Double Run** stitch sews over the line twice: once forward, and once backward, thus it ends up where it starts.

• **The Bean** stitch is also known as a Three Ply stitch and is a running stitch where the machine sews over each stitch three times (forward, back, forward again) before it moves to the next stitch. The result is a heavy running stitch.

• **The Motif Run** is a decorative, programmed stitch which usually has an open, ‘lacy’ look. When you select the Motif run option, the list of Motif patterns at the bottom of the Run area in the Properties becomes active. Scroll down the list to select the Motif you want.

![Brother Text Example](image1.png)

**Steil Style Text**

The Steil stitch is a constant-width satin stitch which follows the outer contour of each letter. The properties specific to Steil are width and density.

![Steil Text Example](image2.png)

The standard lettering properties, such as fill, underlay, and pull-compensation also apply to Steil. For more information about these properties, see “Changing Lettering Properties”.

![Brother Text Example](image3.png)
Appliqué Style Text

If you need to create large letters, Appliqué Style text is one way to reduce the number of stitches required. With Appliqué lettering, you use cut pieces of fabric in place of large fill stitch areas.

There are three different embroidery segments for each letter in appliqué style text:

• Positioning stitches. These sew onto the garment first, and serve as a guide for placing the appliqué fabric.
• Tack-down stitches. Once you have place the appliqué fabric, the tack-down stitches hold it in place.
• The Appliqué border. Border stitches run all the way around the outline of each letter to securely attach the Appliqué fabric to the garment.

There are three different kinds of border stitches possible, Satin, Motif, and Blanket. For more information about the settings for each of these types, see the procedures for each type, below.

Changing colors in Appliqué Text

In order to stop the machine so that you can place the fabric pieces to be sewn on to the garment, the Appliqué Style lettering segment inserts a color change between each positioning, tack-down, and border segment. This means that, when first generated, the lettering segment will display many colors.

You can change the colors of lettering in a Appliqué segment by selecting a color from the list on the Color Palette.
To change the color of letters in an Appliqué Text segment:

1. Select the Appliqué Text segment.

2. In the color palette, find the color you wish to apply to the first of the letter of segment, and click on it. You see the menu of colors.

3. To set the color of the first letter, in the Options menu, click on Color 3. (In the first letter of an Appliqué-style text segment, Color 1 refers to the positioning stitches, and...
Color 2 to the tack-down stitches; Color 3 is the thread color of the visible border stitches).

The first letter changes to the chosen color.

4. Choose the color you wish to apply to the next letter and click on it.

5. From the menu, click on Color 5. (For the second letter of the appliqué segment, the positioning stitches will be sewn using thread color 3, and the tack-down stitches color 4). The second letter will change to the chosen color.
Repeat steps #4 and #5 for each letter in the segment, changing every other color in the appliqué segment, until you have changed all the colors required.

Adjusting Satin Settings for Appliqué Style Text

You can modify the settings and make all changes to the satin stitches in the Appliqué box.

To adjust Satin stitch settings for Appliqué:
1 Select the Appliqué text segment.
2 In the Properties panel, in the Appliqué type field, select Satin.
3 Adjust any of the following settings in the Properties panel:
   • In the Stitch Length box, enter the stitch length of the positioning and tack down runs.
   • In the Appliqué Width box, enter the width of the satin stitching.
   • In the Appliqué Density box, enter the density of the Satin stitching.
   • In the Inset box, select a percentage to inset the edge of the appliqué border, relative to the outline of the lettering.
4 Click Apply.

Adjusting Blanket Settings for Appliqué Style Text

After you select the Appliqué stitch type, you can adjust any of the default settings available. You must make all changes to the Appliqué stitches from the Appliqué box.

To adjust blanket settings for Appliqué:
1 Select the Appliqué text segment.
2 In the Properties panel, in the Appliqué type field, select Blanket.
3 Adjust any of the following settings in the Properties panel:
• In the Stitch Length box, enter the stitch length of the positioning and tack down runs.
• In the Appliqué width box, enter the width of the blanket stitching.
• In the Blanket density box, enter the spacing for the Blanket stitching.

4 Click Apply.

Adjusting Motif settings for an Appliqué Border

After you select the Appliqué stitch type, you can adjust any of the default settings available.

You must make all changes to the Appliqué stitches from the Appliqué box.

To adjust Motif settings for Appliqué:
1 Select the Appliqué text segment.
2 In the Properties panel, in the Appliqué Type field, select Motif.
3 Adjust any of the following settings in the Properties panel:
   • In the Stitch Length box, enter the stitch length of the positioning and tack down runs.
   • In the Inset box, select a percentage to inset the edge of the appliqué border, relative to the outline of the lettering.
   • From the Motif list, select a Motif pattern that will be used as the Appliqué stitching.
• In the Motif Stitch Length box, enter the motif stitch length. The motif stitch length affects the size of the motif and represents the length (width) of each motif pattern.

4 Click Apply.

Fabric Backgrounds in Appliqué Style Text

You have the option of selecting a fabric background to display within the appliqué border. You can select either from a list of fabric images provided with Pacesetter BES Lettering 2, or import your own image file to use as a background.

To display a fabric background in an Appliqué segment:

1 Select the Appliqué text segment.
2 In the Appliqué area of the Properties panel, select the Fabric field.
3 Click the down arrow to the right of the Fabric field. You see a list of available fabrics.
4 Choose one of the fabrics from the list by clicking on it.
5 Click Apply. The selected fabric image appears within the Appliqué border.
To import an image for an Appliqué background:
1 Select the Appliqué Style segment.
2 Open the properties box and select the Appliqué tab.
3 Click the button next to the Appliqué Fabric list. 
   The Import Fabric dialog will open.
   You can scan your own images of fabric swatches for use in your design projects. For best results, scan them with a resolution of 300 dpi. A 1 in. × 1 in. piece of fabric should be sufficient for your sample.
4 Browse to the location of the image you wish to use as a fabric.
5 Select this image and click Open.
   The image appears within the Appliqué border, and it is added to your Appliqué Fabric list.
   The fabric image you import will also be visible in the print-out of the design.

Adjusting Fill Settings
In the properties panel, you can customize the parameters used by Pacesetter BES Lettering 2 when it generates the fill stitching for the segment. You have the option to add a pattern type and change the text object’s density settings.
Choosing a Fill Pattern

When you install Pacesetter BES Lettering 2, a wide variety of Standard and Carved patterns are installed along with the software. You can select which Standard or Carved pattern to use in the Properties box.

To choose the fill pattern:

1. Select the Lettering segment.
2. In the Fill area of the Properties box, in the field labelled Fill Type, select either Standard or Carved.
3. Click on the down arrow on the right of the Pattern field to display a drop-down list of patterns.
   
   You see a list of patterns; the patterns that are displayed depend on the type of fill you chose in step 2.
4 From the Pattern list, select a pattern.
5 Click Apply.

*The fill of your text segment is altered accordingly.*

**Fill Density Setting**

Fill density is the distance between individual lines of embroidery. Density is measured in millimeters.

Note that the density setting is given in millimeters. Therefore, larger values correspond to a lower density, while lower values correspond to a higher density. For more details on stitch density units, see “Density” in the Glossary.

Use the density setting to adjust your fill to suit the fabric you are sewing on. For example, fabrics with a very loose weave are less able to hold a large density of stitches; in cases such as this, you can lower the density of the fill.

If you are unsure what setting to use, try the standard setting of 0.4. This setting works well almost universally, as long as you have not exceeded the font’s size recommendations.
In the Fill area, the image beneath the Density setting will change as you adjust the setting. These are not precise images; rather, they are intended to provide you with visual cues to what you are doing as you change the settings.

A general rule is to go for full-fabric coverage, but add extra stabilizer if you want to support a high-density fill on a low-density fabric.

If the letters in the text segment are large (i.e., above the maximum recommended height for the font) it is better to use a choose a fill, rather than satin, for the lettering. Fill stitches are the type you would normally find filling an area in an embroidery design. With Fill stitches, each line across is made up of two or more individual stitches.

**Carved Fill Properties**

In addition to the density and stitch-length settings described above there are a few extra fill settings that apply only to the Carved fills. You can adjust these Carved pattern settings in the Properties box. The settings allow you to change a fill pattern’s characteristics such as the size and angle of the fill pattern.

The following figures show some different effects you can create using the Carved Fill settings.

![Original (scale at 100%)](image1)

![Emboss Scale at 50%](image2)

**To change the Emboss Scale of a Carved pattern:**

1. Select a Carved fill segment
2 In the Fill area of the Properties Panel, do the following:
   • Click the Emboss Scale box to select this property.
   • In the Emboss Scale field, enter a percentage value to adjust the scaling.
3 Click Apply.

To change the Emboss Angle of a Carved pattern:
1 Select a Carved fill segment
2 In the Fill area of the Properties Panel, do the following:
   • Click the Emboss Angle box to select this property.
   • In the Emboss Angle field, enter a percentage value to adjust the angle.
3 Click Apply.
   You see your segment altered accordingly.

Underlay Properties
Underlay stitches are laid down before the visible, or “top” stitches, to help stabilize stretchy fabrics. They can also help to tack down wales or naps (on fabrics such as corduroy).

There are a variety of possible underlay types available; the following image gives a schematic view of how the different types of underlay are sewn.

The Underlay Area in the Properties panel.
Selecting the Underlay Type
You can select underlay types for various types of stitches. Choose from Contour, Perpendicular, Lattice, Full Lattice, Parallel, or Zig-Zag. You can combine underlay types to get maximum coverage.

Note that not all underlay types will be available for text; in particular, Lattice and Full Lattice underlay will not be available for text segments.

To select an underlay type:
1 Select the segment.
2 In the Properties Panel, scroll down to the Underlay area.
3 Select one or more of the available underlay types.

When you select underlay types, you will be able to see what your underlay type will look like in the Preview area.

4 Adjust any of the other settings. Refer to the related procedures for more information.
5 Click Apply.

Specifying the Underlay Density
You can specify the density for underlay stitches.

To set the underlay density:
1 Select the segment.
2 In the Properties Panel, scroll down to the Underlay area.
3 Select one or more of the available underlay types.
4 In the Density box, enter a density value.
5 Adjust any of the other settings. Refer to the related procedures for more information.
6 Click Apply.
Specifying the Underlay Stitch Length
You can specify the stitch length for your underlay stitches. You can increase or decrease the length according to your underlay needs.

To specify the underlay stitch length:
1 Select the segment.
2 In the Properties Panel, scroll down to the Underlay area.
3 Select one or more of the available underlay types.

When you select underlay types, you will be able to see what your underlay type will look like in the Preview area.

4 In the Stitch Length box, enter the stitch length that you want for your underlay stitches.
5 Adjust any of the other settings. Refer to the related procedures for more information.
6 Click Apply.

Changing the Inset Distance
You can change the inset distance. Pacesetter BES Lettering 2 calculates the inset distance (the distance the underlay stitches are placed from the edge of the top stitching.) Inset distance changes the amount of underlay coverage. The smaller the inset distance, the more coverage you have.

To change the inset distance:
1 Select the segment.
2 In the Properties Panel, scroll down to the Underlay area.
3 Select one or more of the available underlay types.

When you select underlay types, you will be able to see what your underlay type will look like in the Preview area.
4 In the Inset box, enter the amount of distance you want. Enter a zero value if you want to place the underlay directly on the edge of the segment.

5 Click Apply.

**Pull Compensation Settings**

Pacesetter BES Lettering 2 allows you to adjust the pull compensation in your design. In the Properties panel, you can use the settings available in the Pull Compensation area to adjust the pull compensation of text objects.

There are two types of pull-compensation, which differ in the way that the pull compensation is determined.

- A percentage pull-compensation calculates the change made to the stitches’ width based on their original width.
- An absolute pull compensation is simply an extra amount of width which is added to the stitches regardless of their original length.

When you use percentage pull-compensation, you can also enter a value in the Max range box of the Pull Compensation area. This value sets an absolute maximum limit on the size of the pull compensation. If the calculated pull compensation value goes over this length, the actual stitches that are generated will be limited to this length.

**To adjust the pull compensation:**

1 Select the item you want to adjust.
2 Press ALT + Enter to display the Properties panel, if it is not already visible. You see the Properties panel.
3 In the Pull Compensation Area of the Properties panel, click the down arrow to the right of the Type field.
4 A list of options is displayed.
5 Select one of the following options:
   - None. Makes no adjustments to pull compensation.
• Percentage. Enter the percentage in the Value % box and, if necessary, enter the maximum value of pull-compensation in the Max Range box.

You can also adjust the value % number using the value % slider.

• Absolute. Enter the amount of absolute pull-compensation (in mm) in the Absolute Value box.

6 Click Apply.

Displaying Special Characters

When you create lettering, you can enter characters available on your keyboard. You can also enter characters using ASCII numbers, a feature that is available for you to use if needed. An ASCII number is a code number, four digits long, which represents a character that does not have a key to represent it. For instance, ™ or ® are symbols that exist in some fonts but are not type-able on a standard US/English keyboard.

Due to Windows constraints, you must enter the numbers on the keyboard's numeric keypad for this to work.

If you are working from a laptop computer, you will have to enable the keypad in order to use it to input special characters; see your computer’s documentation.

Please note that not all fonts contain all of the special characters. To see which characters are available in any given font, check the font preview information for that font.

You can see the list of available characters for a font by pressing on the button in the Font field of the Text Properties panel, or by hovering your mouse over the font preview.
Special Characters List

The following lists the special characters that may be available in Pacesetter BES Lettering 2.

<table>
<thead>
<tr>
<th>Character</th>
<th>Key Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>€</td>
<td>Alt + 0128</td>
</tr>
<tr>
<td>’</td>
<td>Alt + 0145</td>
</tr>
<tr>
<td>‘</td>
<td>Alt + 0146</td>
</tr>
<tr>
<td>“</td>
<td>Alt + 0147</td>
</tr>
<tr>
<td>”</td>
<td>Alt + 0148</td>
</tr>
<tr>
<td>.</td>
<td>Alt + 0149</td>
</tr>
<tr>
<td>—</td>
<td>Alt + 0151</td>
</tr>
<tr>
<td>™</td>
<td>Alt + 0153</td>
</tr>
<tr>
<td>í</td>
<td>Alt + 0161</td>
</tr>
<tr>
<td>ç</td>
<td>Alt + 0162</td>
</tr>
<tr>
<td>£</td>
<td>Alt + 0163</td>
</tr>
<tr>
<td>®</td>
<td>Alt + 0164</td>
</tr>
<tr>
<td>¥</td>
<td>Alt + 0165</td>
</tr>
<tr>
<td>;</td>
<td>Alt + 0166</td>
</tr>
<tr>
<td>§</td>
<td>Alt + 0167</td>
</tr>
<tr>
<td>..</td>
<td>Alt + 0168</td>
</tr>
<tr>
<td>©</td>
<td>Alt + 0169</td>
</tr>
<tr>
<td>-</td>
<td>Alt + 0173</td>
</tr>
<tr>
<td>®</td>
<td>Alt + 0174</td>
</tr>
<tr>
<td>–</td>
<td>Alt + 0175</td>
</tr>
<tr>
<td>¢</td>
<td>Alt + 0191</td>
</tr>
<tr>
<td>À</td>
<td>Alt + 0192</td>
</tr>
<tr>
<td>Á</td>
<td>Alt + 0193</td>
</tr>
<tr>
<td>Â</td>
<td>Alt + 0194</td>
</tr>
<tr>
<td>À</td>
<td>Alt + 0195</td>
</tr>
<tr>
<td>Â</td>
<td>Alt + 0196</td>
</tr>
<tr>
<td>À</td>
<td>Alt + 0197</td>
</tr>
<tr>
<td>Character</td>
<td>Key Code</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------</td>
</tr>
<tr>
<td>Æ</td>
<td>Alt + 0198</td>
</tr>
<tr>
<td>Ç</td>
<td>Alt + 0199</td>
</tr>
<tr>
<td>È</td>
<td>Alt + 0200</td>
</tr>
<tr>
<td>É</td>
<td>Alt + 0201</td>
</tr>
<tr>
<td>É</td>
<td>Alt + 0202</td>
</tr>
<tr>
<td>Ê</td>
<td>Alt + 0203</td>
</tr>
<tr>
<td>Í</td>
<td>Alt + 0204</td>
</tr>
<tr>
<td>Í</td>
<td>Alt + 0205</td>
</tr>
<tr>
<td>Í</td>
<td>Alt + 0206</td>
</tr>
<tr>
<td>Í</td>
<td>Alt + 0207</td>
</tr>
<tr>
<td>Ï</td>
<td>Alt + 0208</td>
</tr>
<tr>
<td>Ñ</td>
<td>Alt + 0209</td>
</tr>
<tr>
<td>Ó</td>
<td>Alt + 0210</td>
</tr>
<tr>
<td>Õ</td>
<td>Alt + 0211</td>
</tr>
<tr>
<td>Õ</td>
<td>Alt + 0212</td>
</tr>
<tr>
<td>Õ</td>
<td>Alt + 0213</td>
</tr>
<tr>
<td>Õ</td>
<td>Alt + 0214</td>
</tr>
<tr>
<td>×</td>
<td>Alt + 0215</td>
</tr>
<tr>
<td>Ø</td>
<td>Alt + 0216</td>
</tr>
<tr>
<td>Ù</td>
<td>Alt + 0217</td>
</tr>
<tr>
<td>Ú</td>
<td>Alt + 0218</td>
</tr>
<tr>
<td>Ê</td>
<td>Alt + 0219</td>
</tr>
<tr>
<td>Ê</td>
<td>Alt + 0220</td>
</tr>
<tr>
<td>Ÿ</td>
<td>Alt + 0221</td>
</tr>
<tr>
<td>ß</td>
<td>Alt + 0222</td>
</tr>
<tr>
<td>à</td>
<td>Alt + 0223</td>
</tr>
<tr>
<td>á</td>
<td>Alt + 0224</td>
</tr>
<tr>
<td>á</td>
<td>Alt + 0225</td>
</tr>
<tr>
<td>â</td>
<td>Alt + 0226</td>
</tr>
<tr>
<td>â</td>
<td>Alt + 0227</td>
</tr>
<tr>
<td>ã</td>
<td>Alt + 0028</td>
</tr>
</tbody>
</table>
To type special characters:

1. In the text frame, position the cursor where you want to insert the special character.
2. Press and hold down the **ALT** key on your keyboard.

<table>
<thead>
<tr>
<th>Character</th>
<th>Key Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>á</td>
<td>Alt + 0029</td>
</tr>
<tr>
<td>æ</td>
<td>Alt + 0230</td>
</tr>
<tr>
<td>ç</td>
<td>Alt + 0231</td>
</tr>
<tr>
<td>è</td>
<td>Alt + 0232</td>
</tr>
<tr>
<td>é</td>
<td>Alt + 0233</td>
</tr>
<tr>
<td>ê</td>
<td>Alt + 0234</td>
</tr>
<tr>
<td>è</td>
<td>Alt + 0235</td>
</tr>
<tr>
<td>î</td>
<td>Alt + 0236</td>
</tr>
<tr>
<td>í</td>
<td>Alt + 0237</td>
</tr>
<tr>
<td>ï</td>
<td>Alt + 0238</td>
</tr>
<tr>
<td>ì</td>
<td>Alt + 0239</td>
</tr>
<tr>
<td>ð</td>
<td>Alt + 0240</td>
</tr>
<tr>
<td>ñ</td>
<td>Alt + 0241</td>
</tr>
<tr>
<td>ò</td>
<td>Alt + 0242</td>
</tr>
<tr>
<td>ó</td>
<td>Alt + 0243</td>
</tr>
<tr>
<td>ô</td>
<td>Alt + 0244</td>
</tr>
<tr>
<td>õ</td>
<td>Alt + 0245</td>
</tr>
<tr>
<td>ö</td>
<td>Alt + 0246</td>
</tr>
<tr>
<td>÷</td>
<td>Alt + 0247</td>
</tr>
<tr>
<td>ø</td>
<td>Alt + 0248</td>
</tr>
<tr>
<td>ù</td>
<td>Alt + 0249</td>
</tr>
<tr>
<td>ú</td>
<td>Alt + 0250</td>
</tr>
<tr>
<td>û</td>
<td>Alt + 0251</td>
</tr>
<tr>
<td>ü</td>
<td>Alt + 0252</td>
</tr>
<tr>
<td>ý</td>
<td>Alt + 0253</td>
</tr>
<tr>
<td>þ</td>
<td>Alt + 0254</td>
</tr>
<tr>
<td>ÿ</td>
<td>Alt + 0255</td>
</tr>
</tbody>
</table>
3 Type the corresponding key code for the special character from the number pad located on the right side of the keyboard. To view a list of special characters and their corresponding key codes, see "Special Characters List".

4 Release the ALT key on your keyboard. You see the special character.
Once you have learned to create your own designs, you will want to create and save them as files to output to your machine. Pacesetter BES Lettering 2 allows you to save to a number of machine formats.

You can also use the Merge feature to add a stitch file to your lettering. For designs with multiple components (that is, more than one text segment, or a text segment plus a merged design file), you can select the text components and edit them individually.

Topics covered in this chapter:

- Saving designs, and the different stitch file types that are available.
- Selecting, copying, and pasting components of the design.
- Moving and aligning items in your workspace.
- Combining lettering with other designs using the Merge Design Files feature.
Creating New Designs

When you open Pacesetter BES Lettering 2, you can immediately begin creating a new, untitled design in the design window. The design window automatically opens using the default recipe and machine format settings specified in the Preferences dialog. For more information on default settings, see “Setting up your Workspace Environment”.

If you want to open a design and apply a different recipe to it (that is, not the default recipe), you will want to open using the New/Recipe tool.

To create a new design using the recipe dialog:

1. Click the Pacesetter Button , and then click the New/Recipe tool.

   You see the New Page dialog.

2. In the Recipe list, select the recipe you want to use for your design.

   The Recipe description box in the dialog gives you a brief description of each recipe as you scroll through the list in the Recipe drop-down list.

3. In the Machine format list, select the machine format that you want applied to the design when created.

4. Click OK.

   You see a new design window.

If you select the New tool from the Quick Access toolbar, you will bypass the recipe selection dialog. A new design window will open using the default recipe and machine format settings.

You see the New Page dialog.
Opening and Closing Designs

Pacesetter BES Lettering 2 allows you to open designs in a wide variety of file formats. When you open a design file in the design window, your single design file retains the stitches for that design.

To open an existing design:

1. Do one of the following:
   - Click the Open tool on the Quick Access toolbar
   - Click the Pacesetter Button and select Open from the menu.
   
   You see the Open Design dialog box.

2. In the Look in list, browse to the location of the file you want to open.

3. In the Files of type list, select the format for the design you want to open.

4. In the File name box, enter the file name, or select the file you want to open by clicking the file.

5. Select Preview to view a thumbnail (a small representation) of the design.

6. Click Open.

   To view the contents of a zip (compressed) file, select the zip file and click Open. Select the design you want to open from the unzipped file list and click OK.

   To open a file you have recently worked on, click the Pacesetter Button and locate it in the “Recently used designs” list.

To close a design:

- Click the Pacesetter Button, and select Close or Close All from the menu.
Opening Files with the Browser

The Browser is a very convenient way to search for and open files. It allows you to search for and open embroidery files from multiple directories simultaneously.

So, if you have design files stored on a number of different media - for example, a CD, a USB device, as well as on your hard drive - it is possible to look in all of these places at once with the Browser feature. The Browser displays a preview image of the design in its preview pane, as well as the design’s name, overall dimensions, stitch count, and the number of colors that it uses.

You can also use the Browser dialog to merge a design into the current design. (For more information, see “Merging Design Files.”)

To open files using the Browser:

1. Click the Accelerator  button, and then click the Browser tool.

You see the (empty) Browser window.
2 Click in the check boxes next to the directories you want to browse for designs; to look in multiple locations, simply check more boxes.

When you use the Browser, you can speed up your search by restricting it to folders where you know your designs to be.

To narrow the scope of the search, click the small plus + sign next to a folder to expand it. This will display the sub-folders it contains; you can then check only those sub-folders that contain the design files you want to browse.

3 By default, the search will only include those folder that are checked in the list on the left of the browser window. However, you can use the following options to expand the scope of the Browser’s search:

- To include all folders nested within the selected folders, check the “Include subfolders” box at the bottom of the dialog.
- To expand the search to include compressed “ZIP” files, check the “Include ZIP files” box at the bottom of the dialog.

If “Include sub-folders” is checked, this may add a significant amount of time to the search, depending on how many files are in the folder or folders you have selected. If possible, it is better to narrow down you search first, in step 2), to the folder or folders that contain your designs.

Similarly, looking in ZIP files may increase the time needed to search for design, so it is advisable to check this option only if you expect that the designs you need are in a “zipped” folder.

If the search does seem to be taking too long, you can always press the Esc key to cancel it, and start a more limited search.

The preview pane shows a thumbnail image of each design present in the directory or directories you have selected.
4 Do one of the following:

- To select a single design, click on the thumbnail image.
- To select a number of separate designs, click on each individually while holding down Ctrl.
- To select a series of designs, click the first thumbnail, then shift + click on the final thumbnail in the range.

The selected files are highlighted.

5 Do one of the following:
• To open the selected file or files in a new window, click the Open button. The selected design or designs open in your workspace; if multiple designs were opened, each will open in its own tab.
• To merge the selected file or files into the current design, click the Merge button. The embroidery file (or files) will open.

Choosing the Default Recipe
You choose one of the pre-installed recipes through the New design dialog each time you open a new design. The NORMAL recipe is the default for new designs; however, you can set the default to a different recipe through the Preferences dialog box.

To open the Preferences dialog box, go to the View tab on the ribbon and click on the Preferences button.

The recipe you choose then becomes the default for all subsequent design files that you open. The recipes containing fabric settings are applied to all the lettering you create in that design.
You can also change the recipe (style) of a design, or part of a design, after it has been created. With the Select tool active, select part of the design (or, use Ctrl+A to select all of the design) and then right-click; from the context menu that opens, choose Apply Style, and then select the desired recipe from the list.

**Saving a Design**

The Save As command lets you save an alternative version of the design with a different name, location, or file format. Save As is used when you want to keep your original design and create another design with slight modifications. The Save command saves the changes you make to the current design.

**To save a design:**

1. **Pacesetter Button**  
   Do one of the following:
   - Click the Pacesetter Button, and choose Save As from the menu.
   - On the Quick Access Toolbar, choose the Save As tool.  
     You see the Save As dialog box.
2. In the Save in list, browse to the location you want to save your file.
3. In the File Name box, enter the file name for the design you want to save.
4. In the Save As type list, select the file type you want the design to be saved as.
5. Click Save.

**To save changes to the current design:**

- Do one of the following:
  - Click the Pacesetter Button, and choose Save from the menu.
  - On the Quick Access Toolbar, click the Save button.
Selecting and Moving Parts of a Design

The Select Tool

The Select tool allows you to select and modify individual design components, or groups of design components.

Design components that have been selected using the Select tool can be moved, duplicated, or deleted. They can also be resized and rotated in either direction.

To duplicate a component, select it, then press CTRL on the keyboard and click while dragging. When you have reached the desired location on your Workspace, release the mouse button to place the component.

It is important to note that, whenever you open a design, all the components will be grouped by default. Therefore, if you want to use any of the following procedures to select individual segments of the embroidery design, you must first Ungroup the design. To do this, right-click on the design (you will see that the whole thing is enclosed in a selection box, and choose Ungroup from the context menu.

To select one segment in the design:

1. From the Home tab, click the Select tool.
2. Click the design component you want to select.

   The active segment is enclosed in a selection box.
To select multiple components in the design:

1. From the Home tab, click the Select tool.
2. Click a design component. Press CTRL on your keyboard while you click each design component not already selected.
   
   *The active design components will be enclosed in a selection box with handles.*

To select all components of the design:

Using the Select tool, click in the workspace, and draw a box large enough to enclose all components of the design.

- To select all the design components currently in the active window, do one of the following:
  - Click on the small down arrow under the Select tool on the ribbon, and choose Select All.
  - Press Ctrl + A on the keyboard.

To select segments using the Sequence View area:

1. On the Ribbon, choose the Home tab.
2. Click the Select tool to change to Outline Mode.
3. In the Sequence View, select the group of segments which contains the desired segment or segments; if it is not already in expanded view, click the small plus sign next to the group in order to the list of individual segments in the group.
4 To select one segment, click the segment from the list. *In the design workspace, the active segment is enclosed in a selection box with handles.*

5 To select multiple segments within the Sequence View area, do any of the following:
   - Click a segment. Press CTRL on your keyboard while you click each segment not already selected.
   - Click a segment at the start of your selection. Press Shift on your keyboard while you click the segment at the end of your selection. To extend the range of selected segments, press Shift again or Shift+CTRL while you click any segment outside the range of segments already selected. *In the design workspace, the active segments are enclosed in a selection box with handles.*

6 To edit or change the properties of the segments, do any of the following:
   - In the design workspace, right-click the segment(s) and choose any of the options available in the edit menu.
   - In the Sequence View area, right-click the segment(s) and choose any of the options available from the menu.
   - In the Properties box, alter any property settings as required.
Copying, Cutting, and Pasting Design Components

You can use a variety of methods to copy design components in your designs.

To copy to the clipboard:
1. Select one or more design components you want to copy.
2. To copy design components to the clipboard, do one of the following:
   - In the Clipboard area on the Home tab, click on the Copy button.
   - In the design workspace, right-click on the selection and choose Copy from the menu.
   - Press Ctrl + C.
   
   The design components are copied to the clipboard.
3. To paste design components from the clipboard, do one of the following:
   - In the Clipboard area on the Home tab, click on the Paste button.
   - In the design workspace, right-click anywhere and choose Paste from the menu.
   - Press Ctrl + V.

To cut to the clipboard:
1. Select one or more design components you want to cut.
2. To cut design components to the clipboard, do one of the following:
   - In the Clipboard area on the Home tab, click on the Cut button.
   - In the design workspace, right-click on the selection and choose Cut from the menu.
   - Press Ctrl+X.

   The design components are removed from their location.
3 To paste design components from the clipboard, do one of the following:
   • In the Clipboard area on the Home tab, click on the Paste button.
   • In the design workspace, right-click anywhere and choose Paste from the menu.
   • Press Ctrl + V.

**Aligning Items in the Design Horizontally and Vertically**

You can align lettering or design components horizontally or vertically using the Align tools on the Arrange tab.

*Vertical alignment*

- Top
- Center
- Bottom

*Horizontal alignment*

- Left
- Center
- Right

**To align design components:**

1 Select the design components you want to align.
   See “Selecting and Moving Parts of a Design.”
2 On the Arrange tab of the Ribbon, select the appropriate button from the following:

- **Align Left**: Aligns all selected objects to the left-most item selected.
- **Align Right**: Aligns all selected objects to the right-most item selected.
- **Align Top**: Aligns all selected objects to the top-most item selected.
- **Align Bottom**: Aligns all selected objects to the bottom-most item selected.
- **Vertical Center**: Takes all selected objects and centers them in the selection box. The objects are moved so that they are centered top-to-bottom with each other, but they are not moved left or right.
- **Horizontal Center**: Takes all selected objects and centers them in the selection box. The objects are moved so that they are centered left-to-right with each other, but they are not moved up or down.
- **Center**: Centers the selected objects in the current hoop. If more than one object is selected, the entire group is moved together to the center of the hoop; the objects selected remain in the same position relative to each other as they had before being centered.

### Moving Parts of a Design Manually

You can move the component parts of your design relative to each other by dragging them to another location.

**To move a design component manually:**

1. From the Home tab, click the Select tool.
2. Click and drag the design component to its new location.

   *As you drag, the status line displays the horizontal (dx) and vertical (dy) distance.*
Nudging Design Components

Nudging moves the selected design component or group of design components. Nudging is similar to dragging the design component but the distance that the design component moves is smaller.

To nudge up:
• Use Ctrl + ↑.

To nudge down:
• Use Ctrl + ↓.

To nudge left:
• Use Ctrl + ←.

To nudge right:
• Use Ctrl + →

Deleting Design Components

Deleting a design component removes it from the design. The only way to retrieve a design component you delete is to use the Undo tool from the Quick Access toolbar immediately after you delete it.

To delete a design component:

1. From the Home tab, click the Select tool.
2. Select the design component.
3. There are three ways to delete a design component:
   • Right-click and select Delete from the shortcut menu.
   • Press Delete on your keyboard.
   • Choose the Delete command from the Home Tab on the ribbon.
Rotating Design Components
Rotating a design component moves it around the center point of the selection. The rotate tools on the Arrange tab may be used to rotate Text or merged stitch designs through 90º increments. To rotate text through a smaller angle, you can rotate the selection using the handles. See “Rotating the Text Frame” in the section on Creating Text.

You cannot use the Text tool to rotate merged segments, or text segments that have been combined with merged stitch segments.

To rotate segments manually:
1. Select one or more segments you want to rotate.
   The active segment(s) is enclosed in a selection box with handles.
2. Move your mouse over the blue rotation bead beside the top, right or the bottom left design handle. You see the cursor change to a circular arrow.
3. Click and drag the rotation bead to adjust the box to the angle you want.

   The number of degrees of rotation is displayed on the status line in the bottom left corner of the Pacesetter BES Lettering 2 window.

To rotate design components using the Transform tools:
1. Select one or more design components you want to rotate.
   The active design component(s) is enclosed in a selection box.
2. From the Arrange tab on the ribbon, click either of the following:
   Rotate Left: Rotates one or more selected objects to the left by 90º increments.
   Rotate Right: Rotates one or more selected objects to the right by 90º increments.
Working with the Color Palette

In Pacesetter BES Lettering 2, you can change the color of any segment of your design, whether it be a Lettering or a merged stitch file. If you can select it, you can change its color.

The color palette, which is located along the top edge of the design space, shows you the thread colors that are available in the thread chart that is currently selected.

Selecting a Thread Chart

Pacesetter BES Lettering 2 comes with a large number of the most popular manufacturers’ thread charts already loaded. You are able choose from amongst these charts by clicking on the Thread Chart button, which is on the left end of the Color palette. Clicking this button will display the whole list of thread charts as a drop-down list. Click on the one that you want, and those thread colors will be loaded into the color palette.

Searching for a Specific Color

The Find button, located near the left end of the thread palette, allows you to search for a particular thread in the palette, if you know the name or thread number.

To search for a thread color:

1. Click the Find button.
   You see the Thread Color Search dialog.
2. Type in all or part of the name or number of the thread.

If you only know part of the thread name, and there is more than one possible match for that partial name, the search dialog will present you with a number of choices (as in the example below).
3 When you have found the color you want, click on it to select it.

4 Click the Find button.
   *The color you were looking for will now be the selected color in the palette.*

**Changing a Thread Color**

Pacesetter BES Lettering 2 allows you to adjust the colors of the lettering you create, or indeed any segment of the design, by using the Color Palette; you do this by choosing thread objects in the Color palette.

When changing the color of a lettering segment, you can select it with either the Text tool of the Select tool; however, other types of segments (such as those imported with the Merge tool) must be selected with the Select tool.

**To change thread colors:**

1 Do one of the following.
   * Select a segment in the workspace with the Select tool or one of the text tools.
   * In the Sequence view, click on one of the segments.

2 In the Color Palette, click the color box with the thread color you want to use.

   If you hover over a color square on the Palette, the thread type and number will show beside the mouse pointer.
Special Design Tools

There are a number of very useful special features in Pacesetter BES Lettering 2 which you can use to incorporate extra embroidery and effects into your designs. These are described in the following sections.

Merging Design Files

You can merge multiple design files into an active design window. Click on Merge to import an existing design file (or files) and add them to your design. You can merge design files from a variety of formats.

To merge a design:

1. Open an existing design, or create a new design.
2. Click the Merge tool.
   You see the Merge Design File dialog.
3. In the Look in list, browse to the location of the file you want to merge.
4. In the Files of type list, select a design file type for the design you want to merge.
5. In the File Name box, select the design file that you want to merge onto the current open design workspace.
6. To view a preview of the selected design, select Preview, if not already selected.
   A preview image of the selected design appears in the small window on the right-hand side of the dialog.
7 Click Open.

*The merged design file appears in the design workspace.*

You can now select and move the stitch file to place it in the desired position relative to your lettering.
Add Designs Feature

The Add Designs feature allows you to embellish the lettering in your design with extra decorative embroidery. With Add Designs, you can choose from among a wide variety of embroidery accents, borders, frames, and appliqué shapes and place them in your design using only the mouse buttons. These designs come pre-loaded with your Pacesetter BES Lettering 2 software.

When an embroidery design is imported using the Add Design tool, the design will retain its own recipe, which may be different from the one used for the design it is being imported into.

However, you can change the recipe of the imported design, if necessary, by selecting it, right-clicking, and then selecting Apply Style... from the context menu that appears.

To use the Add Designs tool:

1. In the Home tab of the Ribbon, click on the Add Designs tool. 
   You see an option menu.
2. From the option menu, choose any one of the following:
   - Add Accent Design
   - Add Appliqué Design
   - Add Border Design
   - Add Frame Design
   Your pointer changes to a small cross, indicating that the Add Designs tool is active. Notice that the heading in the Properties Panel changes to Add Design.
3. In the Properties Panel, click on the down arrow in the Accent, Appliqué, Border, or Frame field (whichever is applicable) to display a list of available decor types. Depending on whether you have chosen an Accent, Frame, Border, or Appliqué, you will see a different set of options in the list.
4. From the list, click on the one you wish to apply to the design.
5 Place the mouse pointer, at the position you would like the Add Design to begin
6 Click and drag the mouse; as you drag, note that the Add Design appears in outline in your workspace. This outline indicates the size and orientation of the Add Design embroidery, before it is actually generated in your design.

7 To finish placing the Add Design segment, release the mouse button.

You can also insert a design quickly by just following steps 1-4 above, and then double-clicking in the workspace. This will add the selected design at the default size.
8 To adjust the size and orientation of the Add Design segment after it is placed, select it with the Select tool, and use the handles to resize or rotate it.

Your accent, border, frame, or appliqué appears in your design.

Distorting Segments

Distortion, also called morphing, takes a set of stitches and moves them all around in a pattern: It distorts the design. Distortion works with working files (*.BRF) and stitch files or specified stitch segments.

Pacesetter BES Lettering 2 allows you to choose from several distortion effects for your designs. These distortion effects each allow you to adjust them. The adjustments available are Frequency, Amplitude, Angle, Radius and Scale. As you manipulate the controls for these effects, the result is displayed in a preview inside the Distortion dialog.

Distortion Controls: Frequency

The Wave and ZigZag distortions add a series of ‘ripples’ to the selected objects. The number of the ripples is controlled by the Frequency setting. You can experiment with the slider to see different numbers of ‘ripples’ in the preview panel of the
Distortion dialog. The following graphic shows an example of ZigZag distortion.

Distortion Controls: Amplitude

Going back to the ‘ripples’ concept, the amplitude is the height of the ripples. Here is an example ZigZag, but with an increased amplitude (the distortion frequency has been reduced for clarity):
Distortion Controls: Angle

The Twirl effect uses an angle setting to determine how much ‘twist’ the design will be given.

Distortion Controls: Radius

The Pinch effect takes the middle of the design and stretches it so that it looks like a ball. The radius of this ball is controlled by the radius setting. Here is a pinch with a large radius:
Distortion Controls: Scale

The scale is also used by the Pinch effect. It controls how much to expand the 'ball'. The previous picture shows a high scale. The picture below is an example of a low scale:

To distort segments:
1. Open an existing design.
2. Select one or more segments you want to distort.
   
   You can distort all types of segments, including the various text segments and merged stitch segments.

3. From the Arrange tab of the Ribbon, select the Distort tool. The Distort dialog appears with the selected segments displayed in the preview window.

4. In the Style area, select the distortion style you want. You see this style applied to your segments in the preview window.

5. Adjust any of the distortion controls accordingly.

6. Click OK. You see selected segments altered accordingly.
Working with Name Drops

Name Drops allow you to create a model to make a number of similar designs. In a template, each lettering or design segment is treated as a unit that can be replaced. For example, a lettering segment can be changed so that it uses a different font or text, but the segment appears in the same place as the model.

(An example of an application for the Name Drops tool might be to create T-shirts for each player on a sports team; instead of creating a separate design for each T-shirt, use Name drops to create each shirt using the same logo design, but with a different name.)

Each design that will be generated by the tool will have its own row in the dialog, displaying the text, the font, the font height, and the alignment of the lettering. Add a new row for each separate embroidery design you need.

To use the Name Drops Wizard:

1. Create the design you want to use as a basis for the Template; using one of the text tools, include some "placeholder" text in the design.

   The Name Drops will only work with files that contain only a single text segment.

   However, if you want to use a file that already has a text segment in it, you can get around this constraint by converting the original text to stitches. Select the text, right-click, and choose "Preserve as stitches" from the context menu. You can then add a new text segment to the design, and that will be the one that varies in the Name Drops Wizard.

2. Save the design.

3. On Home tab, click on the Name Drops icon.

   You see the Name Drops dialog.
4 In the Output directory box, browse to the folder to use as the destination for the generated files.

5 In the Base filename field, enter a name to use as the basis for the designs generated by the Name Drops wizard. When the files are generated, the file names they will be given will consist of the Base name, plus a sequential two-digit number - e.g. team01.brf, team02.brf, team03.brf, etc.

6 From the radio buttons on the dialog select the behaviour of the Name Drop tool after generating the new files.
   • **Open all files**: Each file will open (in its own tab) in the workspace.
   • **Open first file**: Only the first of the files will open.
   • **Do not open files**: The files will be generated, but not opened.

7 To output the generated files in your choice of stitch format, do the following:
   • Click the Save formats button.

   *The Formats dialog opens.*
Check the box (or boxes) next the file formats that you wish to generate. 

If you choose more than one format, a separate file will be generated for each format.

Click Okay.

The Formats dialog will close; the select format (or formats) will be listed in the Name Drops dialog beside “Save formats.”

8 To add new rows to the Name Drop table, do the following:

- Click the “Add Name” button.
  
  A new row will appear in the Name Drop table, with the Text field already selected.

- Type the next name in the field.

- Repeat the above until all lines have added.

- You can remove a row by clicking the “Remove name” button.

9 In the text column of the table, enter the text needed for each design.

10 If needed, make any of the following modifications to settings in the table by double-clicking the appropriate cell:

- Choose a new font for the text.

- Change the height of each name individually.

- Change the Alignment in the Align cells (left, right, center).
To view these changes as they look in the context of the design, select a column by clicking on it, and then click the Preview button in the final column.

11 Click Save to create the files.

The specified files will be generated, and saved to your destination folder.
Depending on which setting you chose in step 6, one or all of the files will open in your workspace.

Adding Basting Stitches to Designs
You can create a series of stitches that will baste a rectangular outline around the edge of a design. The stitches start at the top left corner of the design; these initial stitches are just jumps and do not sew. Then, a basting run stitch is sewn around the outer edge in a rectangle (close to the inside edge of the hoop) until complete. The next color is then the starting color of the design.

The basting stitches also help you to see that your hooping is lined up correct and straight, a feature that really helps where text is concerned as every error stands out clearly. This feature
is also useful when you want to add a stabilizer to the fabric, but are unable to hoop it, for instance using a water-soluble stabilizer on top of a terry-cloth towel.

**To add basting stitches to designs:**
1. Open an existing design.
2. On the Home tab, in the Text section, click the Auto Baste tool.

   *The basting stitches appear around your design.*

---

**Sequencing Outline Segments**

Using the Sequence View, you can alter the sequence of segments in your designs. You can move them up, down, to the beginning of the sewing order, or to the end. You can also use this view to move a segment to the nearest layer (up or down) of the same thread color.

**Sequencing Segments**

The sequence of the segments is the order in which they are embroidered. The sequence is important because you want segments that are near to each other to sew one after the other. This reduces jump stitches and the need to trim them later.

For example, you can have three objects, all of which start on the left and end on the right. Object 3 is in between Object 1
and Object 2. This might not be optimal for jump stitches, and the machine will take longer to embroider the design in this sequence, compared to if the segments were properly sequenced.

**To sequence segments:**

1. Select one or more segments you want to resequence.
2. Do any of the following:
   - In the design workspace or Sequence View area, click and drag the segment(s) to the location you want.
   - In the design workspace, right-click the segment(s) and choose Move—First, Move—Last, Move—Up, Move—Down, Move—Prev Match or Move—Next Match.
   - In the Sequence View area, right-click the segment(s) in the list and choose Move—First, Move—Last, Move—Up, Move—Down, Move—Prev Match or Move—Next Match.

   The Move—Prev Match and Move—Next Match commands automatically move segment(s) to the previous or next segment group that has the same thread color.

   For more details, see “Moving a Segment to the nearest Matching Color Group.”

**Inserting Segments Earlier in the Segment Sequence**

You can add segments earlier in your design’s segment sequence and change the order segments are sewn.

**To insert segments before the insertion point:**

1. Select and cut, or copy, the segment.
2. In the design workspace or Sequence View area, click where you want to insert the segment.
3. Do one of the following:
   - Choose Insert  from the Home tab on the ribbon.
   - Right-click and choose Insert from the context menu.

   The selection is inserted before the insertion point.
Moving a Segment Forward or Backward

Use the Move Up commands to move the selected segment closer to the beginning of the design. Conversely, the Move Down command is used to move the selected segment closer to the end of the design.

A simple design of three segments (the letters on the left), plus the sequence view of the design. The image above shows the original design, and the one below shows it after a Move Up command. In this case, the Move Up command was used to change the sewing order so that, instead of jumping to the bottom letter and then going back to the middle (A - C - B) the letters sew in order from top to bottom (A - B - C).

To move a segment forward:
1 Select the segment or segments.
2 Do one of the following:
- In the design workspace, right-click the segment(s) and choose Move—Up.
- In the Sequence View area, right-click the segment(s) in the list and choose Move—Up.

*The segment is moved one position forward in the sewing order. This change is reflected in its position in sequence view.*

**To move a segment backward:**
1 Select the segment(s).
2 Do one of the following:
   - In the design workspace, right-click the segment(s) and choose Move—Down.
   - In the Sequence View area, right-click the segment(s) in the list and choose Move—Down.

*The segment is moved one position backward in the sewing order. This change is reflected in its position in sequence view.*

**Moving a Segment to the Start or End of the Design**

Use the Move First command to make the selected segment the first one to be stitched. When a design is sewn, the first segment sewn is usually "on the bottom" or in the "back" of the design. Use the Move Last command to make the selected segment the last one to be stitched. When a design is sewn, the last segment sewn is usually "on top" or in the "front" of the design.

**To move a segment to the start of a design:**
1 Select the segment(s) you want to move to the start of your design.
2 Do one of the following:
   - In the design workspace, right-click the segment(s) and choose Move—First.
In the Sequence View area, right-click the segment(s) in the list and choose Move—First.

In the left image, the green letter A is originally the third segment in the sewing order; after selecting Move—First, it will be behind all the other segments, as shown on the right.

**To move a segment to the end of a design:**

1. Select the segment(s) you want to move to the end of your design.
2. Do one of the following:
   - In the design workspace, right-click the segment(s) and choose Move—Last.
   - In the Sequence View area, right-click the segment(s) in the list and choose Move—Last.

In the left image, the red letter D is originally the design's the second segment; after selecting Move—Last, it will be on top of all other segments, as shown on the right.
Moving a Segment to the nearest Matching Color Group

Pacesetter BES Lettering 2 allows you to automatically move a segment to the previous or next segment group or layer that has the same thread color.

To move a segment to the previous thread color layer:
1. Select the segment(s) you want to move.

2. Do one of the following:
   - In the design workspace, right-click the segment(s) and choose Move—Prev Match.
   - In the Sequence View area, right-click the segment(s) in the list and choose Move—Prev Match.
The selected segment appears in the sequence below the previous group with the same thread color.

To move a segment to the next thread color layer:
1. Select the segment(s) you want to move.
2 Do one of the following:

- In the design workspace, right-click the segment(s) and choose Move—Next Match.
- In the Sequence View area, right-click the segment(s) in the list and choose Move—Next Match.

The selected segment appears in the sequence below the previous group with the same thread color.

Using the Color Sort tool

The Color Sort tool enables you to rebuild a design that has the same color used more than once into a design with a minimum of color stops.

There are times that a color is used more than once in a design by necessity. This occurs when colors need to overlay.

The Color Sort tool analyzes a design to see if any colors are repeated. It then looks to see if any of those repeated colors can be combined into a single layer. If not, the color layers are left intact.

Certain file types have color limitations that make color sort unadvisable. In these cases, the designer ran out of colors and had to re-use a color to complete the design. Also, some designs use color stops to indicate an appliqué or a trim. Not all file types have these functions built-in. In these cases, Color Sort should be used with care.
To use the Color Sort tool:
1 Open an existing design.
2 Select one or more segments to which you want to apply the color sort feature.
3 From the Modify toolbar, click the Color Sort tool.

You will see a dialog appear stating the number of colors reduced in your design. Click OK

Printing Designs
You can make print-outs of your designs in Pacesetter BES Lettering 2. These print-outs not only give you a preview of what the design will look like, but they have a lot of other information as well - the number of stitches in the design and its overall size. Also, by selecting the “Print Color Analysis” option in the Print settings dialog, you can also have printed the color, name, and length of each thread used.

Previewing a Design before Printing
You can preview a worksheet on the screen before sending it to the printer.

To preview a design:
1 From the Quick Access Toolbar, click on the Print Preview button.
2 To zoom in and out of the previewed worksheet, do the following:
   • To zoom in on the worksheet, click Zoom In and scroll to view specific parts of the design.
   • To zoom out on the worksheet, click Zoom Out and scroll to view specific parts of the design.
3 To close print preview and return to the design window, click Close.
Printing Design Worksheets

You can print a design, without previewing it, by selecting the Print Setup toolbar icon. This button opens your computer’s Print dialog, where you can choose printer options such as how many copies you want to print.

You can also print worksheets of your design immediately, without previewing the design or changing printer options. To do this, choose the Direct Print button.

To print a worksheet for your design:

1. Do one of the following:
   - Click the Print Setup button.
   - Press Ctrl+P on the keyboard.

   You see the Print dialog.

2. Make any required changes to the print settings.
3. Click OK to send the file to the printer.
Changing the Print Settings

You can customize print settings for your embroidery designs. Pacesetter BES Lettering 2 allows you to adjust the image and worksheet information displayed in design printouts.

To change a design's print settings:

1. Click the Pacesetter Button , and select Print—Print Preview from the menu.
   You see the print preview window, displaying your design.

2. On the preview's toolbar, click Settings.
   You see the Print Settings dialog.

3. In the Margins area, enter the margin sizes you want for your design worksheet.

4. Select Print Actual Size to have your design print in its actual size.

5. Select Print Color Analysis to print an expanded thread sequence view that includes a view of the colors used, the color sequence, and the thread consumption for each color.
6 Select Print In One Page to print the design on a single worksheet page.

If Print Color Analysis is selected along with Print In One Page, your print out will display a basic thread sequence view. This includes a simplified view of the colors used, the color sequence and the thread consumption.

7 Select Print Company Name to have the name of your company name printed on your design worksheet. Enter your company name in the box below.

8 To prevent jump stitches from showing on your print preview, check the Remove Jump Stitches box.

9 Click OK.

10 Click Close.
APPENDIX:
Foreign Language Fonts

This Pacesetter software application includes several fonts in the foreign-language alphabets. This appendix is a guide that matches the letters in these fonts with the corresponding keystrokes on a regular English keyboard.
Greek font

The following graphic shows the available keystrokes for the Greek font.

Recommended font heights for the Greek font:

Minimum - 0.24 inches/6 mm
Maximum - 0.79 inches/20 mm
Greek Block font

The following graphic shows the available keystrokes for the Greek Block font.

Recommended font heights for the Greek font:

Minimum - 0.24 inches/6 mm
Maximum - 0.79 inches/20 mm
Greek Mixed font

The following graphic shows the available keystrokes for the Greek Mixed font.

Recommended font heights for the Greek font:

Minimum - 0.39 inches/10 mm
Maximum - 1.18 inches/30 mm
Hebrew Traditional font

The following image shows the available keystrokes and letter names of the Hebrew Traditional font.

Note that, in this font, the direction of the letters will be reversed automatically; that is, they will run left-to-right in the Text entry field in the Properties panel, but right-to-left in the design.

Recommended font heights for the Hebrew Traditional font:

Minimum - 0.28 inches/7 mm
Maximum - 1.97 inches/50 mm
Russian font

The following graphic shows the available keystrokes for the Russian font.

Recommended font heights for the Russian font:

Minimum - 0.31 inches/8 mm
Maximum - 1.18 inches/50 mm
Glossary
Automatic Trim
An automated machine process that cuts the top and bobbin thread when directed by data stored in a design file. This function is usually used before a jump or a color change. This process eliminates the need for manual trimming.

Baseline
A line on which lettering segments sit.

Bitmap Images
Paint and image-editing software such as Corel Photo-Paint and Adobe PhotoShop generate bitmap images, also called raster images. Each pixel in a bitmap image has a specific location and color value assigned to it. Bitmap images reproduce the subtle shading found in continuous-tone images, such as photographs. Bitmap images are resolution dependent. They represent a fixed number of pixels; as a result, they can lose detail and appear jagged if they are scaled on-screen.

Color Palette
A collection of thread colors for a particular brand of thread.

Color Stop
A command that instructs an embroidery machine to stop sewing a design in order to change its thread colors. Also known as Color Change.

Column Stitch
Formed by closely arranged zig-zag stitches. Often used to form borders. See also Satin Stitch.

Cross Stitch
Two stitches that cross at the center to form an X.
Density

Density is the number of stitches covering a given area. Large letters, large fill areas and textured fabrics, generally need higher densities. The reverse can be true as well.

There are two measuring systems used in calculating density: Imperial and Metric. The Imperial system measures density in stitches per inch (spi). 65spi means 65 stitches in a 1 inch (linear) area. The Metric system measures density in embroidery points (pt). Points refers to the distance between each thread.

To increase density with the Imperial system, you increase the measurement number. With the Metric system, a higher number of points indicates a lower density. The following example shows what happens when you increase and decrease the density in embroidery points and stitches per inch.

Design Workspace

The design workspace includes the toolbars, menus, ribbon, and the design window containing the design you are editing. You can change the look and functionality of your design workspace by showing or hiding these elements.

Fill Stitch

Series of running stitches commonly used to cover large areas. Different fill patterns can be created by altering the angle, length, and repeat sequence of the stitches.

Grouped Segments

A collection of segments that work together as a single unit. Grouped segments can be ungrouped to access individual segments if the software being used allows this.
Handles
Handles are the small boxes at each corner of the selection box you see around active segments. If you point to a handle, the pointer becomes a double-sided arrow. You can click and drag the handle to resize the selected segment or segments proportionally. Clicking and dragging the control points on the left and right side of a handle will resize the segment by width. Clicking and dragging the control points on the top and bottom sides of a handle will resize the segment by height.

Hoop
Device made from wood, plastic or steel with which fabric is gripped tightly between an inner ring and an outer ring. It attaches to the machine’s pantograph. Machine hoops are designed to push the fabric to the bottom of the inner ring and hold it against the machine bed for embroidering.

Jump Stitch
Movement of the pantograph without needle penetration, commonly used to get from one point in a design to another.

Lettering
Embroidery using letters or words. Lettering commonly called “keyboard lettering” may be created from computer software, which allows variance of letter styles, size, height, density and other characteristics.

Lock Stitch
(1) This stitch is formed by three or four consecutive stitches of at least a 10 point movement. It should be used at the end of all columns, fills and any element where a trim will follow, such as color changes or the end of a design. May be stitched in a triangle or a straight line; (2) Lock Stitch is also the name of the type of stitch formed by the hook and needle of home sewing machines, as well as computerized embroidery machines.
Machine Formats

Machine formats have their own profile settings that determine how embroidery information will be interpreted when you save design files as a machine readable format. When you use machine formats, your design information displays accurately on the screen and designs are sewn correctly on each embroidery machine. You can select a specific machine format for a design when opening or saving designs.

Monogram

Embroidered design composed of one or more letters, usually the initials in a name.

Outline file

File format for storing and retrieving designs, which allows for global changes (automatically changes density, size, stitch width, stitch count in a single operation) within that design.

Pull Compensation

Pull compensation is a technique used to help compensate for the pushing and pulling of fabric that occurs when sewing. Pull compensation changes the width of stitches to compensate for the “give” of fabric. There are two types of pull compensation:
Absolute Pull Compensation:
Absolute Pull Compensation adds the same amount (in linear measure, i.e., inches or mm.) of compensation to each side of the segment, regardless of the original segment width.

Percentage Pull Compensation:
Percentage Pull Compensation increases the width of a fill or satin segment in proportion to the original width.

Recipe
A collection of embroidery settings designed for specific fabrics.

Running Stitch
Consists of one stitch between two points. Used for outlining and fine detail.

Satin Stitch
Formed by closely arranged zig-zag stitches. Also known as a column stitch.

Segment
A single piece of a design that is created at one time. A segment has many properties such as its size, color, sequence in designs, stitch type and values, including stitching instructions.

Select tool
The Select tool allows you to select and modify individual or groups of outline segments. You can select outline segments by clicking on a single segment or by clicking and dragging to draw a box around parts of the design. Once you select outline segments, you can edit the segments.
Index

Numerics
3D tool 16

A
Absolute pull-compensation 86
Align tools 103
Aligning segments 103
Alignment 68
Alignment (Drop Caps) 66
Anchor points 40
Angle, text 47
Applique borders 75
Arc Frame 68
ASCII numbers 86
Auto Baste tool 121

B
Background Color tool 16
Baste stitches 120
Basting 120
Bean stitch 71
Bottom tool (Align) 17, 104
Browser 94–97
Browser tool 13

C
Carved Fill patterns 79, 81
Center tool (Align) 17, 104
Changing anchor point locations 40
Changing colors (Two-color font) 55
Changing font type 60
Changing inset distance 84
Changing patterns 81
Changing Text modes 68
Changing the slant setting 64
Changing thread colors (text) 53
Check Spelling button 62
Color Palette 21, 54, 108
Color Sort 15
Color Sort tool 128
Convert to Cusp command 40
Convert to Line command 40
Convert to Smooth command 40
Convert to Symmetrical command 40
Copying segments 102
Creating Monogram Text 43
Creating new designs 92
Creating Normal Text 36
Creating templates 117
Creating Vertical Text 41
Custom Hoop 29

D
Deleting segments 105
Density 83
Density settings 80
Design components, duplicating 99
Design size 24
Design Window 6, 92, 141
Design workspace 6, 22, 26, 141
Display Hoop command 27
Distorting segments 113
Distortion 113
Distortion effects 113
Distortion tool 17
Double Run stitch 71
Dragging segments 104
Draw Bar 19, 20
Drawing speed settings 20
Drop Caps 66
Duplicating a design component 99

E
Edit Tools 13
Editing Text (Properties box) 58
English units 23

F
File Tools 14
Fill density 80
Fill patterns
  customizing Carved Fill 81
Fill stitches 83
  Underlay types 83
Fit Hoop 16
Flip Horizontal tool 17
Flip Vertical tool 17
Font spacing 63
Font type 60
Frames, text mode 68

G
Greek Block Font 135
Greek Font 134
Greek Mixed font 136
Grid tool 16

H
Handles 142
Help 30–33
  Index 31
  Printing topics 33
  Saving favorite topics 32
  Viewing as a document (PDF) 30
Hoop Selection 28
Hoop tool 16, 28
Hoops, displaying 27
Horizontal Center tool (Align) 17, 104

I
Include all folders (Browser) 95
Inserting segments 122
Inset distance 84, 85

K
Keystrokes 61

L
Left tool (Align) 17, 104
Line Frame tool 15
Line Spacing 68
Lock stitches 142

M
Machine Formats 23, 143
Magnifying views 24
Measuring designs 27
Merge Design tool 13
Merge Stitch File 109
Merging designs 109
Metric units 22
Modify Tools 17
Monogram properties 67
Monogram Text 43
Monogram Text tool 15
Move First command 124
Move Last command 124
Moving Individual Letters 51
Moving segments 123, 124

N
Name Drops 117–120
New Design tool 13
New tool 13
Normal Frame 68
Normal Text 36
Nudging segments 105

O
Open Design tool 13
Opening files in the Browser 94–97
Options 23
<table>
<thead>
<tr>
<th>P</th>
<th>Outline file 143</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pan Tool 26</td>
<td>Running Stitch 144</td>
</tr>
<tr>
<td>Panning 26</td>
<td>Satin stitches 75</td>
</tr>
<tr>
<td>Pasting design components 103</td>
<td>Save 98</td>
</tr>
<tr>
<td>Patterns 79</td>
<td>Save As 98</td>
</tr>
<tr>
<td>choosing 79</td>
<td>Save As dialog 13</td>
</tr>
<tr>
<td>customizing Carved Fill 81</td>
<td>Save tool 13, 14</td>
</tr>
<tr>
<td>Percentage pull-compensation 86</td>
<td>Saving Favorite Help Topics 32</td>
</tr>
<tr>
<td>Percentage(Drop Caps) 66</td>
<td>Saving Projects 98</td>
</tr>
<tr>
<td>Pinch distortion 116</td>
<td>Scrollbar slider 19, 20</td>
</tr>
<tr>
<td>Previewing designs 129</td>
<td>Scrollbars 21</td>
</tr>
<tr>
<td>Print 13</td>
<td>Searching for files (Browser) 94–97</td>
</tr>
<tr>
<td>Print Preview 14, 129, 131</td>
<td>Select Hoop 16</td>
</tr>
<tr>
<td>Print settings 131</td>
<td>Select tool 14, 17, 99, 100, 144</td>
</tr>
<tr>
<td>Printing 130</td>
<td>Selecting underlay types 83</td>
</tr>
<tr>
<td>Printing Help topics 33</td>
<td>Sequencing outline segments 121</td>
</tr>
<tr>
<td>Properties box 58</td>
<td>Sequencing segments 121</td>
</tr>
<tr>
<td>Properties, text 53</td>
<td>Single Run stitch 71</td>
</tr>
<tr>
<td>Pull Compensation 143</td>
<td>Slant setting 64</td>
</tr>
<tr>
<td>Pull-compensation 85–86</td>
<td>Slant, text 47</td>
</tr>
</tbody>
</table>
| Pull-compensation, absolute 86 | Slow Draw Bar  
Scrollbar slider 19, 20  
Speed Control 20 |
| Pull-compensation, percentage 86 | Smooth mode 40 |
| R | Special Characters 53 |
| Rebuilding designs 128 | Special characters 86 |
| Recipe 144 | Speed Control, drawing 20 |
| Redo tool 14, 22 | Spelling Checker 62 |
| Reducing views 24 | Status Line 20 |
| Removing hoops 27 | Stitch files, merging 109 |
| Reset Frame command 69 | Symmetrical 40 |
| Reset Letter command 69 | T |
| Resizing Individual Letters 51 | Templates 117 |
| Right tool (Align) 17, 104 | Text Modes 68 |
| Rotate Left tool 17, 106 | Text Properties 53 |
| Rotate Right tool 17, 106 | Text properties 53, 68 |
| Rotating Individual Letters 52 | Text tool 15 |
| Rotating segments 106 | Thread Colors 108 |
| Ruler tool 27 | |
Thread colors 21
  changing 108
Title Bar 6
Tools
  Edit 13
  File 14
  Modify 17
Tools, Draw Bar 19, 20
Top tool (Align) 17, 104
Twirl distortion 115
Two-color font, changing colors 55

U
Underlay stitch length 84
Underlay types 83
Undo tool 14, 22

V
Vertical Center tool (Align) 17, 104
Vertical Text 41
Vertical Text tool 15
Viewing designs 26, 105
Views tools 24
  Pan 26
  Zoom 24, 25
  Zoom to actual size 25
  Zoom To Fit 25
  Zoom to Selection 25

W
Wave distortion 113
Width compensation 64
Wizards 117
  Templates 117
Worksheet Setting 130
  Print Setting 130
Workspace 6
Workspace environment 22

Z
ZigZag distortion 113
ZIP files 95
Zoom tool 24